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What is DocuShare?
DocuShare is a web-based content management application that lets you use your web 
browser to store, view, edit, and share information with other users across the Internet. 
Anyone with access to your DocuShare site can download and upload documents, create 
and manage repositories called collections, and create calendars, discussions, and other 
site objects.

With DocuShare, you can:

• Create and maintain your own account and workspace without the assistance of a 
web master or site administrator.

• Create collections in which to store documents, in their original format, and other 
types of objects.

• Control user access to collections, documents, and other site objects.

• Set up subscriptions for objects to be notified of any changes, additions, and 
deletions.

• Maintain multiple versions of a document, track its revision history, and lock a 
document to prevent simultaneous editing.

• View new content on your site.

• Search for objects and content on your site.

• Automate document routing tasks.
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Accessing DocuShare
You access DocuShare through a web browser, such as Microsoft Internet Explorer or 
Netscape Navigator. When you connect to your DocuShare site, the DocuShare home 
page is the first page you see. From the home page you can access the content on your 
site and use the navigational links to get to DocuShare features. 

When you first access DocuShare, you are a guest. To add content to the site, you must 
have a user account and be logged in. See Users and groups for more information.

Although your administrator can customize your site home page and different browsers 
may not display site elements the same, your home page should look similar to the 
example shown below.

The DocuShare home page includes these features:

• The site’s top-level collections, which contain all the content on your site

• Login area

• What’s New menu, which you can use to see the content that has been added or 
changed

• Help on getting started using DocuShare

• Links to related information

• Navigation links to other DocuShare pages: Home, Content Map, What’s New, 
Users & Groups, Help

• Search area used to find objects in a collection or on the site
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Navigating your site
The navigation bar at the top of your home page provides links to other DocuShare pages. 
These links also appear at the top of every page.

• Home—returns to the home page.

• Content Map—displays the objects on your site, based on your current location.

• What’s New—lists the new and changed objects on your site.

• Users & Groups—provides links to listing, finding, and creating user and group 
accounts.

• Help—provides access to user guides, tutorials, and software downloads.

• Username—displays your user account properties. Your username displays after 
you log into DocuShare.

• Logout—logs you out of DocuShare. The link displays after you log in.

• My DocuShare—displays your personal home page, which includes your favorites 
and a personal collection and calendar. The link displays after you log in.

• My Tasks—shows the routing tasks assigned to you and the tasks you assigned. 
The link displays after you log in.

• Advanced—provides advanced search features.

In addition, most DocuShare pages include breadcrumbs, which you can use to navigate 
your site. The breadcrumbs either provide a path from the home page to your current 
location or list the last few pages you visited. You can click any link in the breadcrumbs to 
go to the page. For objects that appear in more than one location, multiple breadcrumbs 
are displayed when you click the triangle under Location.

Breadcrumbs for an open collection are shown below. 

Location: Home > Initial Top Level Collection D > My Collection Listing 
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Managing content
Your DocuShare site consists of collections and objects. A collection is like a folder; you 
use it to store other collections and objects. Objects can be documents, calendars, 
discussions, and URLs, and can appear in more than one collection.

You can create any number of collections on your DocuShare site. As the user who 
created the collection, you are the object’s owner and you can control the type of access 
that users have to it. You can also assign a variety of properties to the collection, which 
allow you to provide information about the collection to other users and to customize it.

The figure below shows the contents of a collection titled Training. The collection contains 
a number of objects including: other collections, a document, a URL to another web site, 
and a calendar.

Each DocuShare object is identified by an icon. Table 1–1 shows the current DocuShare 
icons. 

Table 1–1:  DocuShare icons

DocuShare object and its icon

User—A registered DocuShare 
user. 

Group—One or more 
DocuShare users, groups, or 
both. 

Collection—A container for 
storing DocuShare objects. 

Document—A document 
stored on the DocuShare site. 
The icon can vary, depending 
on the document’s file type. 

Discussion—An online forum 
where topics can be posted. 

Topic—A posting to a 
discussion. 
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Assigning properties to objects
Every DocuShare object has an assigned set of properties. For example, the properties 
for all objects include a title, a description, and an owner. Each object has a number of 
specific properties. For example, the sort order property is unique to collections and 
documents have a maximum versions property. Your DocuShare administrator also can 
create custom properties for use at your site. Properties allow you to search for objects.

Controlling access to objects
You can control the level of access users and groups have to DocuShare objects by 
assigning permissions. A collection and the objects it contains can have the same 
permissions, or each object in a collection can have its own permissions. DocuShare 
allows you to assign these access permissions to users and groups:

• Reader allows the user or group to read the contents of the object and view its 
associated properties and permissions.

• Writer allows the user or group to edit the object’s properties and add new 
objects, including new versions of documents.

• Manager allows the user or group to delete the object, and change the object’s 
access permissions and owner.

Your DocuShare administrator has full access permissions to all of the objects on your 
site.

See Access permissions for an explanation of how to assign permissions to DocuShare 
objects.

Calendar—An online monthly 
or weekly calendar. 

Event—A calendar entry. 

Mail Message—An email 
message. 

Saved Query—Saved search 
query terms that can be used 
for a search. 

Subscription—Notification 
after a change occurs to a 
specified DocuShare object. 

URL—An Internet address for a 
web page. 

Table 1–1:  DocuShare icons

DocuShare object and its icon
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Using My DocuShare
My DocuShare is a personalized home page that allows you to keep your favorite objects 
in a single location, store objects in a personal collection, view your browsing history and 
routing tasks, and manage the events from multiple favorite calendars. After logging into 
DocuShare, My DocuShare is accessible from the site home page and on the navigation 
bar. For information on how to set up and use My DocuShare, see My DocuShare.
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Viewing new content on your site
From any page, you can display a list of the content that has been added or changed on 
your site. This lets you quickly find any new or recently changed object or content that 
might be of interest to you.

To find out what’s new:

1. Do one of the following:

• From the home page, select the time period you want under What’s New. 
Click Go.

• On the navigation bar, click What’s New.

DocuShare displays the list of content that has been added or changed.

2. To change the search query used to display the list of new or changed content, 
click the Refine Query button.

The Refine Search page appears.

3. Change any of the search properties and click the Search button. Click a field 
name for a description of the property, or see Running an advanced search on 
page 10–4.

NOTE: If you are a guest user and you click What’s New on the navigation bar, 
DocuShare lists the content that has been added or changed during the past 24 
hours. If you are a logged-in user and you click What’s New on the navigation 
bar, DocuShare lists the content that has been added or changed since you last 
clicked What’s New.
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Logging in and out
When you are not logged into DocuShare, you have guest access to the objects on your 
site. As a guest, you can browse and view content, unless access to it is restricted. 
Logging in enables you to add objects to your site and edit content.

To log into DocuShare:

1. Go to the DocuShare home page.

2. In the Login area, enter your registered username and password in the fields.

Your password is case-sensitive.

3. If the Domain field appears, select your domain name.

NOTE: The Domain field appears if your site uses the LDAP (Lightweight Directory 
Access Protocol) add-on.

4. If the retain login for future checkbox appears, click it if you want to remain 
logged into DocuShare after you close and reopen your browser.

NOTE: The retain login for future checkbox appears if your administrator configured 
your site to use a feature called Persistent Login. For DocuShare to save your 
password, Internet Explorer’s Do not save encrypted pages to disk option 
cannot be enabled. You can check the option’s setting by selecting Internet 
Options from the Tools menu and then clicking the Advanced tab.

5. Click Go.

Your username appears on the navigation bar, indicating that you are logged in.

To log out of DocuShare:

1. Do one of the following:

• If Persistent Login is not enabled or you did not select the retain login for 
future checkbox, close the browser window.

• If you selected the retain login for future checkbox, click the Logout link on 
the navigation bar.
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DocuShare applications
DocuShare provides several applications to extend its functionality.

DocuShare Windows Client—A Windows-based application that seamlessly integrates 
DocuShare's document management features within your Windows desktop environment. 
From your Windows desktop you can easily access DocuShare content, drag and drop 
documents between DocuShare collections and your local and network drives, and open, 
edit, and save DocuShare documents from a variety of applications.

This application is included with DocuShare. To download it, go the Help page and click 
the Downloads tab.

DocuShare Outlook Client—A Windows-based application that enables you to 
conveniently manage and share information within Microsoft Outlook. Mapped DocuShare 
servers and collections appear as mail folders in your Inbox’s Folder List. Open a folder to 
browse the contents of a collection, open documents for editing, and save new versions of 
documents. You can easily archive and share mail messages and attachments by 
dragging and dropping them to a collection. When you need to find information quickly, 
you can perform keyword searches.

This application must be purchased separately.

DocuShare Interact—An easy-to-use editor that enables any number of users to 
collaborate on a project using the web. An Interact page author creates an Interact page 
for a specific task or project. Using a web browser, you and other users can add, revise, 
and share page content. Interact pages can be used for any task that requires or would 
benefit from a collaborative effort, such as managing project tasks, co-authoring a 
document, and assigning and tracking action items.

This application must be purchased separately.
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About DocuShare accounts
By default, DocuShare is a community-maintained site, allowing anyone to create user 
and group accounts. Depending on the needs of your site, the DocuShare administrator 
can restrict account creation to logged-in users or to an administrator.

Additionally, if your site uses the LDAP (Lightweight Directory Access Protocol) add-on to 
manage user accounts, an administrator creates an account for you. To find out how your 
site is configured, see your DocuShare administrator.
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DocuShare user accounts
When you first access DocuShare or until you log in, you are considered a guest user. As 
a guest, you can browse any unrestricted, or public, content. To add objects and edit 
content, you must have a DocuShare user account.

Creating a user account
If your site allows guest users to create accounts, you can create a user account. If 
account creation is restricted, an administrator will need to create a user account for you.

To create a user account:

1. On the navigation bar, click Users & Groups. 

2. Click the Add User tab.

3. On the Add User page, enter the following information:

Username—The name you want to use to log into DocuShare. When creating 
objects, the username is specified as the object’s owner.

Password—The password you want to use to log into DocuShare. Your password 
is case-sensitive and must be typed as specified when logging in.

Password Confirm—The same password that you typed in the Password field.

Domain—An organization or other entity on your DocuShare site. This field 
appears if your site uses the LDAP add-on. The menu lists internal domains only.

Last Name—Your last name. Users are listed on the DocuShare site by their first 
and last names.

4. Enter any optional information. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.

The Properties page for the user account appears.

If DocuShare was unable to create a new account, a message page appears 
describing the problem.
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Viewing user account properties
You can view the properties of any DocuShare user account. To view the properties, you 
do not need to be logged into DocuShare.

To view a user’s account properties:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Users in the Show field.

3. Do one of the following:

• To find a specific user account, enter part of the user’s first name, last name, 
or username in the Search field. Click the Go button.

• To display all user accounts, click Show All.

4. From the displayed list, click the name of the user whose properties you want to 
view.

The Properties page appears, displaying the user’s properties. Click a field name 
for a description of each property. 

Changing your user account properties
You must be logged in as the user whose properties you want to change. You can view, 
but not change, another user’s properties.

To change your user account properties:

1. On the navigation bar, click your username.

The Properties page appears.

2. Click the Edit tab.

3. Change the properties you want. Click a field name for a description of each 
property.

4. Click Apply.

The Properties page appears displaying your new properties.
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Changing your password
You must be logged in as the user whose password you want to change. You cannot 
change another user’s password.

NOTE: If your site uses the LDAP add-on, you cannot change your password. Your 
administrator must change your password on the LDAP server.

To change your current password:

1. On the navigation bar, click your username.

The Properties page appears.

2. Click the Change Password tab.

3. Enter your current password in the Old Password field.

4. Enter your new password in the New Password field.

5. Enter your new password in the New Password Confirm field.

6. Click Apply.

Changing your username
You must be logged in as the user whose username you want to change. You cannot 
change another user’s username.

NOTE: If your site uses the LDAP add-on, you cannot change your username. Your 
administrator must change your username on the LDAP server.

To change your username:

1. On the navigation bar, click your username.

The Properties page appears.

2. Click the Change Username tab.

3. Enter your current password in the Password field.

4. Enter a new username in the Username field.

5. Click Apply.

The Properties page appears displaying your new username. The new name also 
appears on the navigation bar.
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Changing your domain
If your site uses the LDAP add-on, you can change your domain to an internal domain on 
the DocuShare server. You must be logged in as the user whose domain you want to 
change; you cannot change another user’s domain.

To change your current domain:

1. On the navigation bar, click your username.

The Properties page appears.

2. Click the Change Domain tab.

3. Select a new domain from the Domain menu.

4. Click Apply.

Deleting a user account
Only an administrator can delete an existing user account. Contact your administrator if 
you want to delete your user account. If you have several user accounts, your 
administrator can combine any number of the accounts into one account.
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DocuShare group accounts
A group consists of any number of DocuShare users, groups, or both. When your site 
includes groups, you can more easily manage access to collections and objects by 
assigning permissions to the group instead of to each user.

Creating a group
The DocuShare administrator can choose to allow logged-in users to create group 
accounts or to have group account creation under administrative control. If after logging 
into DocuShare, you do not see the Add Group tab on the Users and Groups Registry 
page, then an administrator will need to create a group for you.

To create a group:

1. On the navigation bar, click Users & Groups.

2. Click the Add Group tab.

3. In the Title field, enter a name for the group. The name can contain spaces and 
punctuation marks, and can be identical to another group name.

4. In the Domain field, select a domain name. This field appears if your site uses the 
LDAP add-on. However, the menu lists internal domains only.

5. Enter any optional information. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

6. Click Apply.

The Change Membership page appears.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

9. In the Possible Users/Groups field, select the accounts to add to the group and 
click the Add button. To select multiple accounts, use the CTRL key (Windows) or 
the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the group and click the Remove button. To select multiple accounts, use the 
CTRL key (Windows) or the Command key (Macintosh).
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11. Click Update.

The group members display on the Members page.

Viewing group properties
You can view the properties of any DocuShare group. To view the properties, you do not 
need to be logged into DocuShare.

To view a group’s properties:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the name of the group whose properties you want to 
view.

The Properties page for the group appears. Click a field name for a description of 
each property. 

Changing group properties
Depending on the Change Membership setting, either the logged-in owner of the group 
or a logged-in group member can change the properties of a group.

To change a group’s properties:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose properties you want to change.

The Properties page for that group appears.

5. Click the Edit tab.

6. Change the properties that you want. Click a field name for a description of each 
property.

7. Click Apply.
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Changing the members of a group
Depending on the Change Membership setting, either the logged-in owner of the group 
or a logged-in group member can add and remove members from the group.

To change a group’s members:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose members you want to change.

The Properties page for that group appears.

5. Click the Members tab.

The Members page shows the current group members.

6. To change group members, click the Change Membership button.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

9. In the Possible Users/Groups field, select the accounts to add to the group and 
click the Add button. To select multiple accounts, use the CTRL key (Windows) or 
the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the group and click the Remove button. To select multiple accounts, use the 
CTRL key (Windows) or the Command key (Macintosh).

11. Click Update.

The group members display on the Members page.
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Changing the owner of a group
Only the logged-in owner of the group can change its owner. After changing the group’s 
owner to another user, you will no longer be able to change the group’s members and 
properties, unless Change Membership is set to Members.

To change the owner of an existing group:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose owner you want to change.

The Properties page for that group appears.

5. Click the Edit tab.

6. Click Change Owner.

The Change Owner page appears.

7. Do one of the following:

• To find a specific user account, enter part of the user’s first name, last name, 
or username in the Search field. Click the Go button.

• To display all user accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

8. Select a name from the New Owner field.

9. In the Add Owner to Group field, click Yes to add the new owner to the group.

10. Click Update Owner.

The Properties page appears.
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Changing the domain of a group
If your site uses the LDAP add-on, you can change a group’s domain to an internal 
domain on the DocuShare server. You must be the logged-in owner of the group to 
change its domain.

NOTE: Changing the group’s domain does not change a group member’s domain, if 
one is used.

To change a group’s domain:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter any part of the group’s title in the 
Search field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group whose domain you want to change.

The Properties page for that group appears.

5. Click the Change Domain tab.

6. Select a new domain from the Domain menu.

7. Click Apply.

Sending mail to group members
To easily communicate with a DocuShare group, you can send an email message to the 
group’s members. The message is sent to each member whose user properties include an 
email address. To send email, your web browser must be correctly configured with a mail 
client, such as Microsoft Outlook or Netscape Communicator.

To send email to the members of a group:

1. On the navigation bar, click Users & Groups. 

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter part of the group’s title in the Search 
field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group that you want to send an email message 
to.

The Properties page for that group appears.

5. Click the Mail To tab.

6. To write your message, click the here link.
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Your browser launches an untitled message window with each group member’s 
email address entered in the To field.

7. Compose your message and click Send to email the message to the members of 
the group.

Deleting a group
You can delete a group if you are the logged-in owner of the group.

To delete a group:

1. On the navigation bar, click Users & Groups.

2. On the List page, select Groups in the Show field.

3. Do one of the following:

• To find a specific group account, enter any part of the group’s title in the 
Search field. Click the Go button.

• To display all group accounts, click Show All.

4. From the displayed list, click the group that you want to delete.

The Properties page for that group appears.

5. At the bottom of the page, click the Delete button.

The Confirm Delete page appears.

6. Click Delete to remove the group from your site.

If you do not want to delete the group, click Cancel.
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Finding and listing DocuShare accounts
From the List page, you can quickly search the users and groups registry to determine 
whether or not a user or group has an account on the DocuShare site. You also can list all 
of the user and group accounts registered on the site.

To search for a user or group:

1. On the navigation bar, click Users & Groups.

2. On the List page, select the type of account you want to find in the Show field.

3. In the Search field, enter a complete name or part of a name.

4. Click Go.

The search results display, listing the users, groups, or both who match the search 
text.

To list the accounts on your site:

1. On the List page, select the type of account you want to list in the Show field.

2. Click Show All.

The list of all registered accounts displays.
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DocuShare collections
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About collections
Your DocuShare site consists of any number of repositories, called collections, in which 
you store documents and other objects. The administrator determines which initial set of 
collections appears on the DocuShare home page. As a registered user, you can add 
collections to your DocuShare site.
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Adding a collection
You can add a collection to another collection if you are logged in and have Writer access 
to the existing collection.

To add a collection:

1. Navigate to and open the collection to which you want to add a collection.

The collection page opens showing all of the objects in the collection.

2. From the Add menu, select Collection.

The Add Collection page appears.

3. In the Title field, enter a name for the collection. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

4. Enter any optional information. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties. 

5. Click Apply.

The Properties page for the collection appears, displaying information about the 
new collection.

6. You can click the collection name displayed in the Location breadcrumbs to open 
the collection.

To change the collection’s access permissions, see Access permissions. 
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Viewing and changing collection properties
You do not need to be logged into DocuShare to view a collection’s properties. However, 
only the logged-in owner of a collection or a logged-in user with Writer access to the 
collection can change the properties.

To view and change a collection’s properties:

1. Locate the collection whose properties you want to view and change.

2. Do one of the following:

• If the collection is open, click the Edit Properties link in the upper-right corner 
of the window.

• If the collection is not open (you can view its title in a collection), click the 
Properties icon that appears to the right of the collection’s title.

The Properties page for the collection displays the read-only properties.

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a collection
You can move a collection to another location or have the collection appear in several 
locations on your site. Although a collection can appear in several collections, there is only 
one copy of it, which saves space on your DocuShare site.

To change a collection’s location, you must be logged in and have Writer access to both 
the current and new collection.

NOTE: You can also use the Copy and Paste commands to copy a collection to 
another collection. See Editing multiple objects in a collection on page 3–7.

To change a collection’s location:

1. Open the collection that contains the collection whose location you want to 
change.

2. Do one of the following:

• Click the checkbox that appears next to the collection’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the collection’s title. On 
the Properties page for the collection, click the Locations tab.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the 
collection to appear and click the Add button. To select multiple collections, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want 
the collection to appear and click the Remove button. To select multiple 
collections, use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. 
Otherwise, the collection will become orphaned, which means it will not appear 
in any collection.
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7. Click Update Locations.

The Properties page for the collection appears displaying the collection title(s) in 
which the collection now appears.
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Editing multiple objects in a collection
When viewing an open collection, you can use the Edit Selected menu to perform a 
variety of tasks on one or more objects. For instance, you can add several collection 
objects to your favorites and copy and paste objects between collections.

To edit multiple collection objects:

1. Navigate to and open the collection.

2. Do one of the following:

• To edit some of the objects, click the checkbox next to the objects you want.

• To edit all of the objects, click the checkbox to the left of the Type column 
heading.

3. From the Edit Selected menu, select one of the following commands:

• Add to Favorites—Add the object to Favorites on My DocuShare.

• Copy—Copy the object to the clipboard.

• Paste—Paste the object from the clipboard. Select the command after 
copying one or more objects to the clipboard.

• Delete—Remove the object from your site.

• Rename—Change the object’s title.

• Change Location—Add the object to another location.

• Change Owner—Change the object’s owner.

A confirm window appears.

4. Click Confirm to continue. Depending on which command you selected, 
additional pages may appear.

NOTE: When using the Change Location command, if an object appears in more than 
one collection, only the current collection is listed in the Selected Locations 
field.
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Deleting a collection
You can delete a collection on your DocuShare site if you are the logged-in owner of the 
collection or have Manager access to it. If the collection contains other objects, you can 
choose to delete the collection only or the collection and its contents. To delete the 
collection and its contents, you must be the owner of the objects in the collection or have 
Manager access permission to them.

NOTE: If you delete a collection, but not its contents, and the objects are not located in 
another collection, they become orphaned. You are unable to access orphaned 
objects from a collection. Your administrator can relocate orphaned objects in a 
collection so you can access them again.

To delete a collection:

1. Navigate to the collection that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the collection’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the collection’s title. On 
the Properties page for the collection, click the Delete button.

The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the collection, then you 
do not have Manager access to the object and cannot delete it.

3. From the For collections, delete menu, do one of the following:

• Select Collection and Contents to delete the collection and all of the objects 
in it.

• Select Collection Only to delete the collection, but not its contents.

4. Click Delete to remove the collection from your site.

If you do not want to delete the collection, click Cancel.
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Restoring a deleted collection
If you accidentally delete a collection, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
collection. 
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About documents
Using DocuShare, you can store, access, and manage documents created in a variety of 
popular formats. You add documents to DocuShare by uploading them from your 
computer or a network drive to a collection on your site. With the documents stored in a 
DocuShare collection, users connected to the network can use their browser to search for, 
view, edit, and download a document.

For document management, DocuShare supports version control through its check-out 
and check-in features. By default, DocuShare saves four versions of a document; you can 
change the number of versions DocuShare saves on a per-document basis. In addition, 
you can change a document’s preferred version, which is the version that opens when 
users view, check out, and route the document from a collection. By default, a document’s 
preferred version is its latest version.
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Adding a document to a collection
You add a document to a collection by uploading it from a folder on your local drive or a 
network drive. The upload copies the document to the collection. Once a document is in a 
collection, it is available to others for viewing or collaborative work.

To add a document, you must be logged in and have Writer access to the collection.

To add a document to a collection:

1. Navigate to and open the collection to which you want to add the document.

2. From the Add menu, select Document.

The Add Document page appears.

3. Enter the following information:

Filename—The complete path and filename of the document you want to upload. 
You can click the Browse button to navigate to and select the document.

If you enter the path and filename of a document that does not appear on the 
drive, DocuShare uploads an empty document.

Title—The title of the document. The title should be short, but descriptive, and 
can contain spaces and punctuation marks.

Max Versions—The maximum number of versions to save. When a new version 
of a document is saved to DocuShare, the oldest version is deleted, unless it is 
the preferred version.

4. Enter any optional information. Click a field name for a description of each 
property.

5. Click Apply to upload the document to the collection.

The Properties page for the document appears, displaying information about the 
new document. If you chose to route the document, a Routing Slip appears. For 
information on how to use the Routing Slip, see Routing documents.

NOTE: DocuShare identifies each object on the site with a unique handle (for example, 
Document-37). Therefore, you can upload a document that has a name 
identical to a document stored in a collection.
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Viewing and changing document properties
Any user can view the properties of a document. You can change a document’s properties 
if you are the logged-in owner of the document or a logged-in user with Writer access to 
the document.

To view and change a document’s properties:

1. Open the collection that contains the document whose properties you want to 
view and change.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document displays the read-only properties.

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a document
You can move a document to another collection or have the document appear in several 
collections on your site. Moving a document eliminates the need to delete the document 
and then upload it again. Although a document can appear in several collections, there is 
only one copy of it, which saves space on your DocuShare site.

To change a document’s location, you must be logged in and have Writer access to both 
the document and the new collection.

NOTE: You can also use the Copy and Paste commands to copy a document to 
another collection. See Editing multiple objects in a collection on page 3–7.

To change a document’s location:

1. Navigate to and open the collection that contains the document that you want to 
move.

2. Do one of the following:

• Click the checkbox that appears next to the document’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the document’s title. On 
the Properties page for the document, click the Locations tab.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

• To find specific collections, enter one or more words in the Search field and 
click Go.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the 
document to appear and click the Add button. To select multiple collections, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want 
the document to appear and click the Remove button. To select multiple 
collections, use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. 
Otherwise, the document will become orphaned, which means it will not appear 
in any collection.
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7. Click Update Locations.

The Locations page appears displaying the collection title(s) in which the 
document now appears.
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Viewing a document
DocuShare provides a repository for your documents; your browser controls how a 
document is displayed. By design, browsers are able to handle several types of 
documents and files, such as HTML, GIF, and JPEG. However, for some documents, such 
as Microsoft Word and Excel, your browser launches a helper application (viewer) to run 
or display the document either outside or within the browser window. To play multimedia 
files, the browser uses a plug-in, which opens the file within the browser window.

Your browser is preconfigured to use specific helper applications and plug-ins. Generally, 
if you try to open a document or file that your browser does not recognize, it displays a 
window that guides you in finding the application to use for that type of file.

Unless access to a document is restricted, you can view the content of any document on 
your site. 

To view the content of a document:

1. Navigate to and open the collection that contains the document you want to view.

2. Click the document title.

3. To return to the collection page, do one of the following:

• If the document opened in a separate window, select Exit from the File menu.

• If the document opened within the browser window, click the browser’s Back 
button.

NOTE: If you click the X in the top-right corner of the browser or select Close from the 
File menu, your browser closes and you lose your connection to the DocuShare 
site.
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Viewing an HTML rendition of a document
DocuShare provides an HTML conversion feature that lets you view supported document 
types in HTML format. This feature eliminates the need to configure your browser to 
display certain document types. If a View icon appears to the right of a document’s title, 
then you can view an HTML rendition of the document.

NOTE: The HTML conversion feature cannot convert documents that contain encrypted 
information.

To view an HTML rendition of a document:

1. Open the collection that contains the document you want to view.

2. Click the View icon that appears to the right of the document’s title.

DocuShare converts the document to HTML and displays the document.

3. Click the browser’s Back button to return to the collection page.
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Editing a document
DocuShare supports the complete development cycle of a document, allowing users to 
collaborate on a project. Document check-out and check-in ensures that only one user at 
a time edits a document. Version control maintains a user-specified number of document 
versions.

To edit a document and create a new version, you must be either the logged-in owner of 
the document or a logged-in user with Writer access to it. In addition, the document’s Add 
Versions property must be set to Allowed (default setting). 

NOTE: If DocuShare Windows Client is installed on your computer and you enabled the 
Handle checkout from web browser property in the DocuShare Client 
Properties window, the DocuShare Client Checkin Wizard displays after you edit 
and save the document. When using this feature, make sure DocuShare’s URL 
in the browser is the same as the server’s address in Windows Client. To check 
the server’s address, right-click the server name and select Properties.

To edit a document:

1. Navigate to and open the collection that contains the document that you want to 
edit.

2. Click the Check Out icon that appears to the right of the document’s title.

The document opens in the browser window, or a window appears allowing you to 
open or download the document. When the document is checked out, it is locked, 
which prevents other users from editing it.

3. Edit the document.

4. Do one of the following:

• If the document opened in the browser, click the Back button. Click Yes to 
save your edits.

• If the document opened in its native editor, select Save As from the File 
menu.

5. In the Save As window, save the document to a location on your local drive.

Do not change the name of the document.

6. On the collection page, click the Properties icon that appears to the right of the 
document’s title.

The Properties page for the document appears.

7. At the bottom of the page, click the New Version button.

8. On the Add Version page, click the Browse button.

9. Navigate to the location on your local drive in which you saved the edited 
document, select it, and click Open.

The path to the document appears in the Filename field.
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10. In the Title field, you can change the document title. By default, the new version is 
assigned the original document title.

11. Optionally, enter any comments in the Version Comments field.

12. For Unlock Document, click No if you do not want to unlock the document after 
adding the new version.

13. When a document version other than the latest is the preferred version, you can 
click Yes in the Make This The Preferred Version field to set this version as the 
preferred one. Otherwise, click No to not change the preferred version.

14. Click Apply.
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Adding a new version of a document
You can add a new version of a document by uploading a document from a folder on your 
local drive or a network drive. To add a new version, you must either be the logged-in 
owner of the document or have Writer access to it. In addition, the document’s Add 
Versions property must be set to Allowed (default setting). 

To add a new version of a document:

1. Navigate to and open the collection that contains the document that you want to 
update with a new version.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.

3. At the bottom of the page, click the New Version button.

4. On the Add Version page, click the Browse button.

5. Navigate to the location on your local drive that contains the document you want 
to add as a new version, select it, and click Open.

The path to the document appears in the Filename field.

6. In the Title field, you can change the document title. By default, the new version is 
assigned the original document title.

7. Optionally, enter any comments in the Version Comments field.

8. If the previous version of the document was locked, the Unlock Document field 
appears. Click No if you do not want to unlock the document after adding the new 
version.

9. When a document version other than the latest is the preferred version, you can 
click Yes in the Make This The Preferred Version field to set this version as the 
preferred one. Otherwise, click No to not change the preferred version.

10. Click Apply.



Managing document versions DocuShare documents

4–12  Release 4.0.1

 
 

Managing document versions
DocuShare’s version control feature enables you to maintain a record of a document's 
history. For each version DocuShare saves, you can view the content, the date and time 
the version was added to the collection, the user who added the version, and any user-
provided comment. You can also view and edit each version’s properties and permissions, 
and route individual versions. 

By default, DocuShare saves four versions of a document. You can change the default 
setting by changing the document's Max Versions property. See Viewing and changing 
document properties on page 4–4.

Viewing document versions
To view a document’s version history:

1. Navigate to and open the collection that contains the document whose version 
history you want to view.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.

3. Click the Version History tab.

The page displays all saved versions of the document.

4. To view a specific version of the document, click its type or version number.

5. To return to the Version History page, do one of the following:

• If the document opened in a separate window, select Exit from the File menu.

• If the document opened within the browser window, click the browser’s Back 
button.

Changing the preferred version
By default, a document’s preferred version is the latest version. When there is more than 
one version of a document, you can change the document’s preferred version. This is the 
version of the document that opens when users view, check out, and route the document 
from a collection. However, users can route a specific document version from the 
document’s Version History page.

DocuShare always saves the preferred version, regardless of the number of Max 
Versions specified.

To change a document’s preferred version:

1. Display a document’s Version History page.

2. Click Change Preferred Version.

Radio buttons display next to each version and the Use Latest Version option 
appears.
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3. Do one of the following:

• To select one of the existing versions as the preferred version, click the radio 
button next to the version you want.

• To always have the latest version of the document be the preferred version, 
click the radio button next to Use Latest Version.

4. Click Apply.

Viewing the renditions of a version
Each version of a document can consist of a number of renditions. A rendition is the 
version’s display format, such as Microsoft Word, Adobe PDF, or HTML, and can be 
comprised of content files. For example, an HTML rendition of a particular document 
version would consist of the HTML file and several image files if the rendition contained 
graphics. 

To view a version’s renditions:

1. Display a document’s Version History page.

2. To view the version renditions, click Show Renditions.

The version renditions display and, if a rendition contains content files, those files 
display.

3. You can click a rendition or a content file to view it.

4. Click Hide Renditions to not view the renditions.

Viewing and changing version properties
Any user can view the properties of a version. You can change a version’s properties if 
you are the logged-in owner of the version or a logged-in user with Writer access to the 
version. 

To view and change a version’s properties:

1. Display a document’s Version History page.

2. Click the Properties icon that appears to the right of the version’s title.

The Properties page for the version displays the read-only properties.

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

5. Click Apply.

To change a version’s access permissions, see Access permissions.
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Locking a document
If you are the logged-in owner of the document or a logged-in user with Writer access to 
the document, you can lock it to keep other users from editing the document. 

To lock a document:

1. Navigate to and open the collection that contains the document that you want to 
lock.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.

3. At the bottom of the page, click the Lock button.

On the View page, the Locked By property displays your name as the user who 
locked the document.

4. Return to the collection that contains the document by clicking the collection title 
displayed after Appears In. The Locked icon appears to the right of the 
document title.

Users can view the document, but they cannot check out the document for editing.
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Unlocking a document
If you do not want to add a new version of a document to a collection, you can unlock a 
locked document. To unlock a document and allow users to edit the document, you must 
be the logged-in owner of the document or a logged-in user with Writer access to it. A 
document is locked if a Locked icon appears to the right of the document’s title.

To unlock a locked document:

1. Navigate to and open the collection that contains the document that you want to 
unlock.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.

3. At the bottom of the page, click the Unlock button.

On the View page, the Locked By property does not display a username.

4. Return to the collection that contains the document by clicking the collection title 
displayed after Appears In. The Check Out icon appears to the right of the 
document’s title.

Users can now check out the document for editing.
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Downloading a document
You can download a document from a DocuShare collection to your computer. The 
download copies the document and keeps the original document in the collection.

To download a document:

1. Navigate to and open the collection that contains the document that you want to 
download.

2. Click the document that you want to download.

The document opens.

3. From the File menu, select Save As.

4. Select a location on your computer where you want to save the document.

5. Click Save.

A copy of the document downloads to your computer.

6. To return to the collection page, do one of the following:

• If the document opened in a separate window, select Exit from the File menu.

• If the document opened within the browser window, click the browser’s Back 
button.
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Deleting a document
You can delete a document from a collection if you are the logged-in owner of the 
document or a logged-in user with Manager access to it. 

To delete a document:

1. Open the collection that contains the document that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the document’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the document’s title. On 
the Properties page for the document, click the Delete button.

The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the document, then you 
do not have Manager access to the object and cannot delete it.

3. Click Delete to remove the document from your site.

If you do not want to delete the document, click Cancel.
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Restoring a deleted document
If you accidentally delete a document, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
document.
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About access permissions
Every DocuShare object has a set of associated permissions called its access list. 
Permissions are the access rights that a defined set of users and groups has to view, 
delete, or change a DocuShare object. The object's owner or any user with Manager 
access to the object can assign and change the permissions.

As the owner of the DocuShare objects that you add to your site, you can control the type 
of access users and groups have to those objects. When you add an object to a collection, 
you set the object’s initial permissions. At any time you can change the users and groups 
who have access to the object and the type of access each user or group has.

DocuShare provides the following access permissions that you can assign to users and 
groups:

• Reader allows the user or group to read the contents of the object and view its 
associated properties and permissions.

• Writer allows the user or group to edit the object’s properties and add new 
objects, including new versions of documents.

• Manager allows the user or group to delete the object, and change the object’s 
access permissions and owner.

In addition, you can control who can see an object in a search results list.
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Viewing the access permissions of an object
As a guest user or a user with Reader access to an object, you can view the object’s 
access permissions.

To view an object’s access permissions:

1. Locate the object whose permissions you want to view.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for that object appears.

3. Click the Permissions tab.

The Permissions page displays the object’s access list, which includes the 
object’s owner, the site administrator, and three DocuShare groups:

Content Administrators—The registered users who have full access 
permissions to all of the objects on your DocuShare site.

All Users and Guest—All registered DocuShare users and the guest user.

All Users Except Guest—All registered DocuShare users.
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Changing the access permissions of an object
You can change an object’s access permissions if you are the logged-in owner of the 
object or a logged-in user with Manager access to the object.

To change an object’s access permissions:

1. Locate the object whose permissions you want to change.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for that object appears.

3. Click the Permissions tab.

The Permissions page for that object appears.

4. For Search Available to, click Anyone to allow guests and users to view the 
object in a search results list. Click Access List Only to allow only those accounts 
included in the object’s access list to see the object in a search results list.

5. If you want to change the list of users and groups who have access to the object, 
click the Change Access List button.

The Change Access List page appears.

6. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

7. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

8. In the Possible Users/Groups field, select the accounts to add to the access list 
and click the Add button. To select multiple accounts, use the CTRL key 
(Windows) or the Command key (Macintosh).

9. In the Selected Users/Groups field, select any accounts that you want to remove 
from the access list and click the Remove button. To select multiple accounts, use 
the CTRL key (Windows) or the Command key (Macintosh).

10. Click Update Access List.

The Permissions page appears, displaying the new access list.

11. Check the permission boxes you want for each user and group displayed in the 
access list.

12. Click Apply.
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Changing the owner of an object
The default owner of an object is the user who initially created the object. You can change 
an object’s owner if you are the logged-in owner of the object or a logged-in user with 
Manager access to the object. 

NOTE: When you change the owner of a container or a document, only that object’s 
owner is changed; the owners of the container’s objects or the document 
versions are not changed.

To change the owner of an object:

1. Locate the object whose owner you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the object’s title. From the Edit 
Selected menu, select Change Owner. On the confirmation page, click 
Confirm.

• Click the Properties icon that appears to the right of the object’s title. Click 
the Permissions tab and then click the Change Owner button.

The Change Owner page appears.

3. Do one of the following:

• To find a specific user account, enter part of the user’s first name, last name, 
or username in the Search field. Click the Go button.

• To display all user accounts, click Show All.

• To display your favorite user accounts, click Show Favorites.

4. Select a name from the New Owner field.

5. Click Update Owner.

The Permissions page for the object appears, displaying the name of the new 
owner at the top of the access list. The new owner has Reader, Writer, and 
Manager permissions.

The name of the previous owner remains in the access list.
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Applying permissions to the objects in a 
container
When you change the access permissions of a collection, calendar, or discussion that 
includes objects, you can choose how to apply the container’s permissions to its contents. 
You can choose to apply all of the permissions or only the changed permissions to either 
the container or the container and its contents.

You can change a container’s access permissions if you are the logged-in owner of the 
container or a logged-in user with Manager access to it.

To apply a container’s access permission to the objects in it:

1. Locate the container whose permissions you want to change.

2. Click the Properties icon that appears to the right of the container’s title.

The Properties page for that container appears, displaying the current properties.

3. Click the Permissions tab.

The Permissions page for that container appears.

4. Make the changes you want to the access list.

5. For Options, select one of the following:

• Apply all permissions to—Assigns all of the access permissions.

• Apply only changes to—Assigns only the changed access permissions.

6. Select one of the following:

• This container only—Applies the permissions to the container only. The 
permissions of the container’s objects are not changed.

• This container and its objects, including same objects that appear in 
other containers—Applies the permissions to the container and the objects 
in it. The permissions of the same objects that appear in other containers also 
are changed.

• This container and its objects, excluding same objects that appear in 
other containers—Applies the permissions to the container and the objects 
in it. The permissions of the same objects that appear in other containers are 
not changed.

7. Click Apply.
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Applying permissions to a document and its 
versions
Since each version of a document has its own access list, when you change a document’s 
access permissions you can choose how you want to apply the changes to the 
document’s versions. You can change a document’s access permissions if you are the 
logged-in owner of the document or a logged-in user with Manager access to it.

To apply a document’s access permission to its versions:

1. Locate the document whose permissions you want to change.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for that document appears, displaying the current properties.

3. Click the Permissions tab.

The Permissions page for that document appears.

4. Make the changes you want to the access list.

5. For Apply all permissions to, select one of the following:

• This document and its versions—Assigns the changed permissions to the 
document and all of its versions.

• This document only—Assigns the changed permissions to the document 
only. The document and its versions will have different access permissions.

6. Click Apply.
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About calendars
You can add a calendar to a collection to keep track of your appointments, meetings, and 
other activities. If you and a group of co-workers are responsible for a project, you can 
share a calendar to manage the tasks and schedules.

The entries you add to a calendar are called events. An event can occur all day or during 
a specified time period. In addition, an event can occur once or repeatedly, such as a 
weekly staff meeting or a class.

You can display a calendar in either month, week, or day view.

Month view
Month view displays an entire month with the current day highlighted. From the current 
month, you can click a link for the previous month and the next month. You can also 
display calendars for previous and following years.

The start time and title of each calendar event is shown on the date to which it was added.

Week view
Week view displays an entire week with the current day highlighted. From the current 
week, you can click a link for the previous week and the next week. You can also display 
calendars for previous and following years.

The duration, title, and owner of each event is shown on the date to which it was added. 

Day view
Day view displays the current day. From the current day, you can click a link for the 
previous day and the next day. You can also display a day from another month or year.

The day view shows the duration, title, and owner of each event added to the date. 
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Adding a calendar
You can add a calendar to a collection if you are logged in and have Writer access to the 
collection.

To add a calendar to a collection:

1. Navigate to and open the collection to which you want to add a calendar.

The collection page opens showing all of the objects in the collection.

2. From the Add menu, select Calendar.

The Add Calendar page appears.

3. In the Title field, enter a name for the calendar. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

4. Enter any optional information. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.

The Properties page for the calendar appears, displaying information about the 
new calendar.

6. You can click the calendar name displayed in the Location breadcrumbs to open 
the calendar.

To change the calendar’s access permissions, see Access permissions.



Changing the calendar view DocuShare calendars

6–4  Release 4.0.1

 
 

Changing the calendar view
When viewing a calendar, you can change among the three views.

To change the calendar view:

1. Navigate to and open the calendar.

2. From the View menu, select either Month View, Week View, or Day View.
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Viewing and changing calendar properties
You do not need to be logged into DocuShare to view a calendar’s properties. However, 
only the logged-in owner of a calendar or a logged-in user with Writer access to the 
calendar can change the calendar’s properties.

To view and change a calendar’s properties:

1. Locate the calendar whose properties you want to view and change.

2. Do one of the following:

• If the calendar is open, click the Edit Properties link in the upper-right corner 
of the window.

• If the calendar is not open (you can view its title in a collection), click the 
Properties icon that appears to the right of the calendar’s title.

The Properties page for the calendar displays the read-only properties. 

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a calendar
You can move a calendar to another collection or have the calendar appear in several 
collections on your site. Although a calendar can appear in several collections, there is 
only one copy of it, which saves space on your DocuShare site.

To change a calendar’s location, you must be logged in and have Writer access to both 
the calendar and the new collection.

NOTE: You can also use the Copy and Paste commands to copy a calendar to another 
collection. See Editing multiple objects in a collection on page 3–7

To change a calendar’s location:

1. Navigate to and open the collection that contains the calendar whose location you 
want to change.

2. Do one of the following:

• Click the checkbox that appears next to the calendar’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the calendar’s title. On 
the Properties page for the calendar, click the Locations tab.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the 
calendar to appear and click the Add button. To select multiple collections, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want 
the calendar to appear and click the Remove button. To select multiple 
collections, use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. 
Otherwise, the calendar will become orphaned, which means it will not appear 
in any collection.
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7. Click Update Locations.

The Properties page for the calendar appears displaying the collection title(s) in 
which the calendar now appears.



Deleting a calendar DocuShare calendars

6–8  Release 4.0.1

 
 

Deleting a calendar
You can delete a calendar if you are the logged-in owner of the calendar or a logged-in 
user with Manager access to it. When you delete a calendar, all of the events in it are also 
deleted.

To delete a calendar:

1. Navigate to and open the collection that contains the calendar you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the calendar’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the calendar’s title. On 
the Properties page for the calendar, click the Delete button.

The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the calendar, then you do 
not have Manager access to the object and cannot delete it.

3. Click Delete to remove the calendar from your site.

If you do not want to delete the calendar, click Cancel.
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Restoring a deleted calendar
If you accidentally delete a calendar, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
calendar.
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Adding an event to a calendar
You can add an event to a calendar if you are logged in and have Writer access to the 
calendar. You can set the event so that it occurs on a regular basis, such as every Monday 
or every two weeks. 

To add a calendar event:

1. Open the calendar to which you want to add an event.

2. From the Add menu, select Event.

The Add Event page appears.

3. In the Title field, enter a name for the event.

4. Optionally, enter a description of the event in the Description field.

5. In the Date field, select the date on which the event is to occur.

6. For Time, do one of the following:

• Select No Time if the event is to occur all day.

• Select the beginning and ending times if the event is to occur during a 
specified time period. Be sure to select am or pm as appropriate.

7. If the event is to occur on a regular basis, select the Repeat frequency and 
number of occurrences.

8. For Initial Permissions, select one of the following:

• Same as container assigns the container’s access permissions to the object.

• Same as container except write restricted to owner assigns the users who 
have Reader access to the container with Reader access to the object. You 
are the only user with Writer access to the object.

• Restricted to owner assigns full access permissions only to you, the object’s 
owner.

9. Click Apply to add the event to your calendar.

The Properties page for the event appears, displaying information about the new 
event.

10. You can click the calendar name displayed in the Location breadcrumbs to open 
the calendar.

The event you added appears in the calendar.

To change the event’s access permissions, see Access permissions.
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Viewing and changing calendar event 
properties
You can view and change the properties of a calendar event such as the title or time. If the 
event is recurring, the change is made to each event in the series. To change the 
properties, you must be the logged-in owner of the event or a logged-in user with Writer 
access to the event.

To view and change a calendar event’s properties:

1. Navigate to and open the calendar that contains the event you want to view and 
change.

2. Click the title of the event.

The Properties page for the event displays the read-only properties.

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

5. Click Apply.
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Deleting a calendar event
You can delete a calendar event if you are the logged-in owner of the event or a logged-in 
user with Manager access to it. However, if the event is one of a recurring series, you 
need only Writer access to the event to delete it.

To delete a calendar event:

1. Navigate to and open the calendar that contains the event you want to delete.

2. Click the title of the event.

The Properties page for the event appears.

3. At the bottom of the page, click the Delete button.

4. On the Confirm Delete page, do one of the following:

• If the event is a single occurrence, click the Delete button.

• If the event occurs more than once, click the Delete All Events in This 
Series button to delete all occurrences of the event from the calendar; click 
the Delete Just This Event button to delete the event from the date you 
selected.

NOTE: Your administrator can restore a deleted non-recurring single event or a deleted 
recurring event series. However, your administrator cannot restore a single 
event that was deleted from a recurring event series.
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Changing the location of a calendar event
You can move an event to another calendar or have it appear in several calenders. To 
move an event, you must be logged in and have Writer access to both the event and the 
new calendar.

Although an event can appear in several calendars, there is only one copy of it, which 
saves space on your DocuShare site.

To change the location of a calendar event:

1. Navigate to and open the calendar that contains the event you want to move.

2. Click the title of the event.

The Properties page for the event appears.

3. Click the Locations tab.

The Locations page appears, showing the event’s current location(s).

4. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

5. Do one of the following:

• To find specific calendars, enter one or more words in the Search field. Click 
the Go button.

• To display all calendars, click Show All.

• To display your favorite calendars, click Show Favorites.

6. In the Possible Locations field, select the calendar(s) in which you want the 
event to appear and click the Add button. To select multiple calendars, use the 
CTRL key (Windows) or the Command key (Macintosh).

7. In the Selected Locations field, select any calendars in which you do not want 
the event to appear and click the Remove button. To select multiple calendars, 
use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one calendar appears in the Selected Locations field. 
Otherwise, the event will become orphaned, which means it will not appear in 
any calendar.

8. Click Update Locations. 
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About discussions
To facilitate an online exchange of ideas, DocuShare supports threaded discussions. You 
can add a container to a collection, called a discussion, in which users add topics for other 
users to read and reply to. As users reply to a topic, their responses are sequentially 
linked, or threaded, to the original topic. Users can read or reply to any of the topics or 
replies in a thread.
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Adding a discussion
You can add a discussion to a collection if you are logged in and have Writer access to the 
collection.

To add a discussion to a collection:

1. Navigate to and open the collection to which you want to add a discussion.

The collection page opens showing all of the objects in the collection.

2. From the Add menu, select Discussion.

The Add Discussion page appears.

3. In the Title field, enter a name for the discussion. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

4. In the Topics Expire In field, select the length of time to retain topics and their 
message threads in the discussion after they are added.

When a topic becomes older than the duration you select, it no longer appears in 
the discussion. You can view and delete expired topics on the discussion’s View 
Expired page.

5. Enter any optional information. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

6. Click Apply.

The Properties page for the discussion appears, displaying information about the 
new discussion.

7. You can click the discussion name displayed in the Location breadcrumbs to 
open the discussion.

To change the discussion’s access permissions, see Access permissions.
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Viewing and changing discussion properties
You do not need to be logged into DocuShare to view a discussion’s properties. However, 
only the logged-in owner of a discussion or a logged-in user with Writer access to the 
discussion can change the properties.

To view and change a discussion’s properties:

1. Locate the discussion whose properties you want to view and change.

2. Do one of the following:

• If the discussion is open, click the Edit Properties link in the upper-right 
corner of the window.

• If the discussion is not open (you can view its title in a collection), click the 
Properties icon that appears to the right of the discussion’s title.

The Properties page for the discussion displays the read-only properties.

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a discussion
You can move a discussion to another collection or have the discussion appear in several 
collections on your site. Although a discussion can appear in several collections, there is 
only one copy of it, which saves space on your DocuShare site.

To change a discussion’s location, you must be logged in and have Writer access to both 
the discussion and the new collection.

NOTE: You can also use the Copy and Paste commands to copy a collection to 
another collection. See Editing multiple objects in a collection on page 3–7.

To change a discussion’s location:

1. Navigate to and open the collection that contains the discussion whose location 
you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the discussion’s title. From the 
Edit Selected menu, select Change Location. On the Confirm Change 
Location page, click Confirm.

• Click the Properties icon that appears to the right of the discussion’s title. 
Click the Locations tab.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the 
discussion to appear and click the Add button. To select multiple collections, use 
the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want 
the discussion to appear and click the Remove button. To select multiple 
collections, use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. 
Otherwise, the discussion will become orphaned, which means it will not appear 
in any collection.
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7. Click Update Locations.

The Properties page for the discussion appears displaying the collection title(s) in 
which the discussion now appears.
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Deleting a discussion
You can delete a discussion on your DocuShare site if you are the logged-in owner of the 
discussion or have Manager access to it. When you delete a discussion, all of its current 
and expired topics are also deleted.

To delete a discussion:

1. Navigate to and open the collection that contains the discussion you want to 
delete.

2. Do one of the following:

• Click the checkbox that appears next to the discussion’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the discussion’s title. On 
the Properties page for the discussion, click the Delete button.

The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the discussion, then you 
do not have Manager access to the object and cannot delete it.

3. Click Delete to remove the discussion from your site.

If you do not want to delete the discussion, click Cancel.
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Restoring a deleted discussion
If you accidentally delete a discussion, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
discussion.
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Adding a topic to a discussion
A topic is the first message added to a discussion and initiates the online conversation. 
Users can reply to the topic as well as to individual replies. By default, replies are 
indented, which provides a hierarchical display of the discussion.

You can add a topic to a discussion if you are logged in and have Writer access to the 
discussion.

To add a topic:

1. Open the discussion to which you want to add a topic.

2. Click the Add Topic button.

NOTE: If your administrator created a custom topic, it appears in the Add menu.

3. In the Title field, enter a name for the topic.

4. In the Description field, enter the topic message. The description appears below 
the title in a discussion. You can include HTML tags in the topic’s description.

5. Click Submit.

The topic appears in the discussion.

To change the topic’s access permissions, see Access permissions.

Adding replies
If you are logged in and have Writer access to the topic or reply, you can add a reply. 

To add a reply:

1. Navigate to and open the discussion.

2. Locate the topic or reply to which you want to reply.

3. Click the Reply button.

4. Enter a title and description.

5. If you want to include the previous message and the name of the user who added 
it, click Quote Post.

6. Click Submit.
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Viewing and changing the properties of a 
topic or reply
Any user can view the properties of a topic or reply. You can change the properties of a 
topic or reply if you are logged into DocuShare and have Writer access to the object.

To view and change the properties of a topic or reply:

1. Navigate to and open the discussion that contains the topic or reply you want to 
change.

2. Click the Properties icon that appears to the right of the object.

The Properties page for the object displays the read-only properties.

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

5. Click Apply.
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Deleting a topic or reply
You can delete a topic or reply if you have Manager access to it or you are the object’s 
owner. You also must be logged into DocuShare. When you delete a topic or reply, any 
message threads also are deleted.

To delete a topic or reply: 

1. Navigate to and open the discussion that contains the topic or reply you want to 
delete.

2. Do one of the following:

• Click the Properties icon that appears to the right of the object’s title. At the 
bottom of the Properties page, click the Delete button.

• Select the checkbox that appears next to the object’s title. From the Edit 
Selected menu, select Delete.

The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the topic or reply, then 
you do not have Manager access to the object and cannot delete it.

3. On the Confirm Delete page, click the Delete button.

If you do not want to delete the object, click Cancel.
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Changing the location of a topic
You can move a topic and its message thread to another discussion or have it appear in 
several discussions. To move a topic, you must be logged in and have Writer access to 
both the topic and the new discussion.

Although a topic can appear in several discussions, there is only one copy of it, which 
saves space on your DocuShare site.

To change the location of a topic:

1. Navigate to and open the discussion that contains the topic you want to move.

2. Click the Properties icon that appears to the right of the topic’s title.

The Properties page for the topic appears.

3. Click the Locations tab.

The Locations page appears, showing the topic’s current location(s).

4. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

5. Do one of the following:

• To find specific discussions, enter one or more words in the Search field. 
Click the Go button.

• To display all discussions, click Show All.

• To display your favorite discussions, click Show Favorites.

6. In the Possible Locations field, select the discussion(s) in which you want the 
topic to appear and click the Add button. To select multiple discussions, use the 
CTRL key (Windows) or the Command key (Macintosh).

7. In the Selected Locations field, select any discussions in which you do not want 
the topic to appear and click the Remove button. To select multiple discussions, 
use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one discussion appears in the Selected Locations field. 
Otherwise, the topic will become orphaned, which means it will not appear in 
any discussion.

8. Click Update Locations.
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Viewing and deleting expired topics
If you set an expiration for the topics added to a discussion, you can view and delete the 
expired topics. To delete expired topics, you must be logged in and have Manager access 
to the topics.

To view and delete expired topics:

1. Navigate to and open the collection that contains the discussion whose expired 
topics you want to view.

2. Click the Properties icon that appears to the right of the discussion’s title.

The Properties page for the discussion appears.

3. Click the View Expired tab.

The page displays all of the expired topics that no longer appear on the 
discussion.

4. Do one of the following:

• Select the individual topics that you want to delete.

• Click Select All to select all of the topics.

5. Click Delete Selected.
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About DocuShare URLs
A DocuShare URL is a link to a web page. Adding a URL to a collection enables you to 
easily share useful and interesting web pages with other DocuShare users and guests. 
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Adding a URL
You can add a URL to a DocuShare collection if you are logged in and have Writer access 
to the collection. 

To add a URL to a collection:

1. Navigate to and open the collection to which you want to add a URL.

The collection page opens showing all of the objects in the collection.

2. From the Add menu, select URL.

The Add URL page appears.

3. In the URL field, enter the Internet address of the web page (for example, http://
docushare.xerox.com).

While viewing the web page in a browser, you can copy the URL from the 
Address or Location field and paste it into the URL field.

4. In the Title field, enter a name for the URL. The name should be short, but 
descriptive, and can contain spaces and punctuation marks.

5. Enter any optional information. Click a field name for a description of each 
property.

6. Click Apply.

The Properties page for the URL appears, displaying information about the new 
URL.

7. You can click the collection name displayed in the Location breadcrumbs to see 
the URL object.

To change the URL’s access permissions, see Access permissions.
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Viewing and changing URL properties
You do not need to be logged into DocuShare to view a URL’s properties. However, only 
the logged-in owner of a URL or a logged-in user with Writer access to the URL can 
change its properties.

To view and change a URL’s properties:

1. Navigate to and open the collection that contains the URL whose properties you 
want to view and change.

2. Click the Properties icon that appears to the right of the URL’s title.

The Properties page for the URL displays the read-only properties. 

3. Click the Edit tab.

4. Change the properties you want. Click a field name for a description of each 
property.

NOTE: If your administrator created custom properties, they also display on the page. 
See your administrator for information about custom properties.

5. Click Apply.
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Changing the location of a URL
You can move a URL to another collection or have the URL appear in several collections 
on your site. Although a URL can appear in several collections, there is only one copy of it, 
which saves space on your DocuShare site.

To change a URL’s location, you must be logged in and have Writer access to both the 
URL and the new collection.

NOTE: You can also use the Copy and Paste commands to copy a URL to another 
collection. See Editing multiple objects in a collection on page 3–7.

To change a URL’s location:

1. Navigate to and open the collection that contains the URL whose location you 
want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the URL’s title. From the Edit 
Selected menu, select Change Location. On the Confirm Change Location 
page, click Confirm.

• Click the Properties icon that appears to the right of the URL’s title. Click the 
Locations tab.

The Change Location page appears.

3. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the 
URL to appear and click the Add button. To select multiple collections, use the 
CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want 
the URL to appear and click the Remove button. To select multiple collections, 
use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. 
Otherwise, the URL will become orphaned, which means it will not appear in 
any collection.
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7. Click Update Locations.

The Properties page for the URL appears displaying the collection title(s) in which 
the URL now appears.
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Deleting a URL
You can delete a URL on your DocuShare site if you are the logged-in owner of the URL or 
a logged-in user with Manager access to it.

To delete a URL:

1. Navigate to and open the collection that contains the URL that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the URL’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the URL’s title. On the 
Properties page for the URL, click the Delete button.

The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the URL, then you do not 
have Manager access to the object and cannot delete it.

3. Click Delete to remove the URL from your site.

If you do not want to delete the URL, click Cancel.
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Restoring a deleted URL
If you accidentally delete a URL, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
URL. 
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About subscriptions
A subscription allows you to be notified of a change to a DocuShare object. You can add a 
subscription for any object on your site. For example, you can add a subscription for a 
document to have DocuShare notify you when a new version of the document is added to 
a collection. You might want to add a subscription for a collection to know when new 
content is added to the collection.

DocuShare notifies you by email when a change occurs. You can choose to receive 
immediate notification or receive a summary report on a daily or weekly basis.

You can add a subscription for any of the following changes to an object:

Any change—Any change to an object.

Something added—A new object is added to a collection, calendar, or discussion.

New document version added—A new version of a document is added to a collection.

Something deleted—The object is deleted.

Properties edited—The object’s properties are changed.

Permissions edited—The object’s permissions are changed.

Change in ownership—The object’s owner is changed.

Location edited—The object’s location is changed.

Document locked or checked out—The document is locked or checked out.

Document unlocked—The document is unlocked after being locked, but a new version of 
it was not added.

NOTE: To use DocuShare subscriptions, your administrator must configure the server 
with an SMTP mail gateway for outgoing mail. Your user account properties 
must include an email address.
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Adding a subscription
You can add a subscription for an object if you are logged in and have Reader access to 
the object. If the object is a collection, you can choose how to apply the subscription to the 
collection and the objects in it. If the object is a calendar or discussion, the subscription 
applies to the container and all of the objects in it.

To add a subscription:

1. Navigate to the object for which you want to add a subscription.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for the object appears.

3. Click the Subscriptions tab.

4. In the Events of Interest field, select one or more events. To select multiple 
events, use the CTRL key (Windows) or the Command key (Macintosh).

5. In the Period field, select one of the following time periods:

• Immediate provides notification immediately after the event occurs.

• Daily provides notification in a daily summary report.

• Weekly provides notification in a weekly summary report.

6. In the Include Recipient Activity field, select Yes to also notify the user whose 
action caused the subscription notification. Otherwise, select No.

7. In the Sender field, select the username that appears in the email message From 
field: Admin or Owner.

8. Enter any optional information. Click a field name for a description of each 
property.

9. Click Apply.

The subscription does not appear as an object in a collection. Subscriptions 
appear on the object’s Subscriptions page.
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Viewing subscriptions
You must be logged into DocuShare and have Reader access to the object to view its 
subscriptions.

To view an object’s subscriptions:

1. Navigate to the object whose subscriptions you want to view.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for the object appears.

3. Click the Subscriptions tab.

A list of the object’s current subscriptions display.
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Viewing and changing subscription properties
To view an object’s subscription properties, you must be logged-in and have Reader 
access to the object. You must be the logged-in owner of a subscription or a logged-in 
user with Writer access to the subscription to change the subscription’s properties.

To view and change an object’s subscription properties:

1. Navigate to the object whose subscription properties you want to view and 
change.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for the object appears.

3. Click the Subscriptions tab.

A list of the object’s current subscriptions display.

4. Click the Properties icon that appears to the right of the subscription you want to 
change.

The Properties page for the subscription displays the read-only properties.

5. Click the Edit tab.

6. Change the properties you want. Click a field name for a description of each 
property.

7. Click Apply. 
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Creating a recipient list for a subscription
You can create a recipient list for a subscription to have DocuShare notify others when a 
change occurs to an object. For example, you may want co-workers to know when a new 
version of a document is added to a collection or when an object is moved to another 
location.

You must be the logged-in owner of a subscription or a logged-in user with Writer access 
to the subscription to create a recipient list.

To create a recipient list for a subscription:

1. Navigate to the object that has the subscription for which you want to create a 
recipient list.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for the object appears.

3. Click the Subscriptions tab.

A list of the object’s current subscriptions display.

4. Click the Properties icon that appears to the right of the subscription you want to 
change.

The Properties page for the subscription appears.

5. Click the Recipients tab.

6. Click Change Recipients.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. Do one of the following:

• To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

• To display all accounts, click Show All.

• To display your favorite accounts, click Show Favorites.

9. In the Possible Users/Groups field, select the accounts to add to the recipient list 
and click the Add button. To select multiple accounts, use the CTRL key 
(Windows) or the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the recipient list and click the Remove button. To select multiple accounts, 
use the CTRL key (Windows) or the Command key (Macintosh).

11. Click Update.
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Deleting a subscription
You can delete a subscription if you are the logged-in owner of a subscription or a logged-
in user with Manager access to the subscription.

To delete a subscription:

1. Navigate to the object whose subscription you want to delete.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for the object appears.

3. Click the Subscriptions tab.

A list of the object’s current subscriptions display.

4. Click the Properties icon that appears to the right of the subscription you want to 
delete.

The Properties page for the subscription appears.

5. Click the Delete button.

The Confirm Delete page appears.

6. Click Delete.
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Restoring a deleted subscription
If you accidentally delete a subscription, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
subscription.
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About DocuShare searches
DocuShare search features enable you to quickly find objects on your site. You can 
perform simple word searches by having DocuShare find the objects that contain the text 
you specify. You also can combine several search terms to find specific objects, such as 
all documents authored by one user that contain the word DocuShare in their titles. When 
searching for objects, you can search all of the collections on the site or a single collection.

When an object is added to a collection, DocuShare indexes and stores in a database the 
object’s properties (also called metadata) and, if the object is a document, its content. A 
search checks the database to find the objects that match your search terms. In addition, 
DocuShare uses a process called stemming to find objects that contain variations of the 
word you specify. For example, a search for the word bath will find the words baths and 
bathes.
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Searching for objects
From the home page or any collection page you can search for objects and content. You 
do not need to be logged into DocuShare to run a search.

To run a quick search:

1. On the home page or a collection page, enter one or more words in the Search 
field.

If you want DocuShare to search for an exact phrase or a phrase that includes a 
search operator, enclose the phrase in quotation marks (for example, “war and 
peace”).

2. If you are running the search from a collection page, do one of the following:

• Click This Collection to search the current collection only.

• Click Entire Site to search all collections.

3. Click Go.

DocuShare displays the search results. For documents, DocuShare either 
provides a snippet of the document content with the search term highlighted or 
displays the document’s abstract if the search term is not found in the content. 
You can click the Show/Hide Details button to control this display. 

Search options
When running a quick search, you can specify several options to narrow the search and to 
control how the search results are displayed.

To run a quick search using search options:

1. Enter the search words in the Search field and, if the In field appears, select the 
search scope.

2. Click the small triangle next to the Go button and specify any of the following 
information:

Search Text Contained In—Specifies the location of the search words. Any Text 
searches the object’s content and properties.

Last Modified—Limits the search to objects that were last changed within a 
specific time period.

Object Types—Specifies the type of objects to search.

Document Types—Searches for all types of documents or a specific type. The 
Object Types must be set to All Object Types or Documents Only.

Maximum Results—The maximum number of objects to display in the search 
results list. DocuShare orders the results by displaying the most relevant objects 
first.

Sort Results—The order in which to display the search results.

3. Click Search.

DocuShare displays the search results.
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Running an advanced search
Using the Advanced Search page, you can further narrow a search by combining search 
terms, specify ranges, and search for specific objects and documents.

To run an advanced search:

1. On the home page or a collection page, click the Advanced link.

2. If you are running the search from a collection, select the search scope in the 
Search Within field.

3. In the Maximum Results field, select the maximum number of objects to display 
in the search results list. DocuShare orders the results by displaying the most 
relevant objects first.

4. In the Sort Results field, select the order in which to display the search results.

5. Under Search Text Contained In, enter the search term. Create a search term by 
selecting where the search words should occur, selecting an operator, and then 
entering the search word or words. If you want DocuShare to search for an exact 
phrase or a phrase that includes a search operator, enclose the phrase in 
quotation marks (for example, “war and peace”).

You can click + add search term to create another search term using a logical 
operator. See Table 10–1 for a description of each logical operator.

NOTE: For information on how to use wildcard and nonalphanumeric characters in a 
search term, see Using reserved characters in a search on page 10–7.

6. Under Limit Search to Date Range, enter the date range to use when searching 
for objects. Create a date range by selecting options from the menus and entering 
a date.

You can click + add date range to create a second date range.

7. Under Find Results with Numeric Range, enter the numeric range to use when 
searching for objects whose properties have numeric values.

You can click + add numeric range to create a second numeric range.

NOTE: This field appears if an object has a numeric property that is searchable.

8. Under Object Types to Search, do one of the following

• To search all of the objects on the site, click Search all object types.

• To search specific objects only, click Limit search to selected object types 
and select the objects to search from the list.
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9. If you searching all object types or documents only, under Document Types to 
Search, do one of the following

• To search all types of documents, click Search all document types.

• To search specific types of documents, click Limit search to selected 
document types and select the types of documents to search from the list. 
Each document type is specified by its MIME type.

10. Click the Search button. 

DocuShare displays the search results. For documents, DocuShare either 
provides a snippet of the document content with the search term highlighted or 
displays the document’s abstract if the search term is not found in the content. 
You can click the Show/Hide Details button to control this display 

Table 10–1: Logical operators

Logical operator Meaning

And Searches for objects that contain all of the search 
terms. 

For example: Search for objects where “Title contains 
Training And Summary contains Basic Product.”

The search would return only objects that have the word 
“Training” in the Title, and the phrase “Basic Product” in 
the Summary.

Or Searches for objects that contain one of the search 
terms. 

For example: Search for objects where “Title contains 
Advanced Or Summary contains Administrator.”

The search would return objects that have either the word 
“Advanced” in the Title or the word “Administrator” in the 
Summary, or both the word “Advanced” in the Title and 
“Administrator” in the Summary.

Accrue Searches for objects that contain at least one of the 
search terms, and relevance ranks the results by 
displaying the objects that contain the largest number 
of search terms first.

For example: Search objects where “Title contains 
Advanced Accrue Summary contains Administrator.”

The search would first return objects that have both 
Advanced in the Title and Administrator in the Summary, 
then objects that contain just one of the search terms 
(either Advanced in the Title or Administrator in the 
Summary).
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And Not Searches for objects that contain one search term and 
not the other.

For example: Search objects where “Title contains 
Technology And Not Title contains Marketing.”

The search would return only those objects where 
Technology was in the Title, but not return objects if 
Marketing was also in the Title.

Table 10–1: Logical operators

Logical operator Meaning
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Using reserved characters in a search
You can use these wildcard characters when building a search:

Question mark ?—Specifies any single alphanumerical character. 
For example: ?an returns ban, can, dan, fan, etc.

Asterisk *—Specifies any number of alphanumerical characters. 
For example: corp* returns corporate, corporation, corporal, corpulent, etc.

NOTE: To find objects that include a wildcard character, select the specific property 
name, use the equals operator, and precede the character with two backslashes 
(\\). For example, to search for a document named *ReadFirst enter: Title 
equals \\*ReadFirst.

To find objects that include nonalphanumeric characters, such as at signs (@) and equal 
signs (=), or nonalphanumeric and wildcard characters, select the specific property name, 
use the equals operator, and enclose the search text within single quotation marks.

Example: To search for jbrown@mycompany.com, enter:

(User) Email Address equals ‘jbrown@mycompany.com’

Example: To search for jbrown@* enter:

(User) Email Address equals ‘jbrown@*’

NOTE: Three nonalphanumeric characters, the ampersand (&), dash (-), and 
underscore (_), are considered alphanumeric characters and do not require any 
special treatment. For example, to search for my_document.doc, enter 
my_document.doc.
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Saving a search query
A saved search query consists of a defined set of search terms. You can save a search in 
a collection to reuse it or to share it with other users. You can save a search query after 
running a search, or you can define a search query and save it.

To save a search query, you must be logged in.

To save the query used in a search:

1. Define your search terms and run a search.

The search results display.

2. From the Add menu, select Saved Query.

The Add Saved Query page appears.

3. In the Title field, enter a title for the saved query.

4. Enter any optional information. Click a field name for a description of each 
property. 

5. Click Save Search.

The Properties page for the query appears. You need to add the saved query to a 
collection.

6. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

7. In the Possible Locations field, select the collection(s) in which you want the 
saved query to appear and click the Add button. To select multiple collections, 
use the CTRL key (Windows) or the Command key (Macintosh).

8. In the Selected Locations field, select any collections in which you do not want 
the saved query to appear and click the Remove button. To select multiple 
collections, use the CTRL key (Windows) or the Command key (Macintosh).

9. Click Update Locations.

DocuShare adds your search query to the collection. When you click the saved 
query, DocuShare runs the search using the saved search terms and displays the 
results.
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Changing saved query properties
You can change the properties and search terms of a saved query if you are the logged-in 
owner of the query, or you are logged in and have Writer access to it.

To change a saved query’s properties:

1. Open the collection that contains the saved query whose properties you want to 
change.

2. Click the Properties icon that appears to the right of the saved query’s title.

The Properties page for the saved query displays the read-only properties. 

3. Click the Edit tab.

4. Change the properties you want.

5. Click Apply.

6. Click the Edit Query tab.

7. Change the search terms you want.

8. Click Apply.

DocuShare saves the changes to the saved query.
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Changing the location of a saved query
You can move a saved query to another collection or have the saved query appear in 
several collections on your site. Although a saved query can appear in several collections, 
there is only one copy of it, which saves space on your DocuShare site.

To change a saved query’s location, you must be logged in and have Writer access to both 
the saved query and the new collection.

NOTE: You can also use the Copy and Paste commands to copy a saved query to 
another collection. See Editing multiple objects in a collection on page 3–7.

To change a saved query’s location:

1. Navigate to and open the collection that contains the saved query whose location 
you want to change.

2. Do one of the following:

• Click the checkbox that appears to the left of the saved query’s title. From the 
Edit Selected menu, select Change Location. On the Confirm Change 
Location page, click Confirm.

• Click the Properties icon that appears to the right of the saved query’s title. 
Click the Locations tab.

3. In the Sort By field, select Title to display the possible locations in alphabetical 
order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the 
saved query to appear and click the Add button. To select multiple collections, 
use the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want 
the saved query to appear and click the Remove button. To select multiple 
collections, use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. 
Otherwise, the saved query will become orphaned, which means it will not 
appear in any collection.
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7. Click Update Locations.

The Properties page for the saved query appears displaying the collection title(s) 
in which the saved query now appears.
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Deleting a saved query
You can delete a saved query if you are the logged-in owner of the query or a logged-in 
user with Manager access to it.

To delete a saved query:

1. Open the collection that contains the saved query that you want to delete.

2. Do one of the following:

• Click the checkbox that appears next to the saved query’s title. From the Edit 
Selected menu, select Delete.

• Click the Properties icon that appears to the right of the saved query’s title. 
On the Properties page for the saved query, click the Delete button.

The Confirm Delete page appears.

3. Click Delete to remove the saved query from your site.

If you do not want to delete the saved query, click Cancel.
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Restoring a deleted saved query
If you accidentally delete a saved query, your administrator can restore it if the trashcan is 
enabled on your site. The trashcan holds deleted objects until your administrator 
expunges or restores the trashcan contents. See your administrator to restore a deleted 
saved query.
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About My DocuShare
My DocuShare lets you easily manage personal content from a single page. Your favorite 
objects, personal collection, favorite calendars, browsing history, and routing tasks are all 
accessible from My DocuShare.

After logging into DocuShare, a link to My DocuShare appears on the site home page and 
on the navigation bar. The figure below shows a My DocuShare page.



My DocuShare Managing favorites

DocuShare User Guide  11–3

 
 

Managing favorites
To conveniently access frequently used objects from a single location, you can add them 
to your favorites. Any object you add as a favorite is a link to the original object, not a copy. 
If the original object is deleted, it will no longer appear in your favorites.

To add an object to your favorites:

1. Navigate to the object that you want to add to favorites.

2. Do one of the following:

• Click the checkbox that appears next to the object’s title. From the Edit 
Selected menu, select Add to Favorites. On the Confirm Add to Favorites 
page, click Confirm.

• Click the Properties icon that appears to the right of the object’s title. At the 
bottom of the Properties page for the object, click Add to Favorites.

3. On the navigation bar, click My DocuShare.

The object you added appears under Favorites. The View menu lets you display 
one type of favorite object, such as favorite documents. You can click the 
Favorites heading to display your favorites in a collection listing. In this view you 
can use standard collection features.

To remove an object from your favorites:

1. Open My DocuShare.

2. Click the Favorites heading.

3. From the Edit Selected menu, select Remove Favorite.

4. On the Confirm Remove from Favorites page, click Confirm.

The object no longer appears in favorites. However, the object still appears in its 
original location(s).
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Using your personal collection
Your personal collection on My DocuShare is a private repository for your objects. By 
default, only you and a group of administrators called Content Administrators have full 
access to the collection.

To add an object to your personal collection:

1. Open My DocuShare.

2. Click the Personal Collection heading.

3. From the Add menu, select the type of object you want to add.

4. On the Add page, enter the required information and click Apply.

5. On the navigation bar, click My DocuShare.

The object you added appears under Personal Collection. The View menu lets 
you display one type of object, such as documents.

To view your personal collection in full page:

1. Open My DocuShare.

2. Click the Personal Collection heading.

The objects display in a collection listing. In this view you can use standard 
collection features such as adding new objects and changing the collection’s 
properties.

NOTE: When you click the Delete button on the Properties page for the collection, you 
can delete the collection and, optionally, its contents. However, the next time 
you access My DocuShare your personal collection appears.
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Using your personal calendar
Your personal calendar is a combination of all your favorite calendars. This allows you to 
merge the events from separate calendars into a master calendar. For example, you can 
add individual vacation calendars to your favorites to create a single vacation calendar for 
a group.

To create a personal calendar:

1. Navigate to the calendar that you want to add to favorites.

2. Do one of the following:

• Click the checkbox that appears next to the calendar’s title. From the Edit 
Selected menu, select Add to Favorites. On the Confirm Add to Favorites 
page, click Confirm.

• Click the Properties icon that appears to the right of the calendar’s title. At 
the bottom of the Properties page for the object, click Add to Favorites.

3. Repeat steps 1 and 2 to add additional calendars to favorites.

4. On the navigation bar, click My DocuShare.

The single, personal calendar appears under Favorite Calendars.

5. Using the View menu, you can switch between daily and weekly views of the 
calendar.
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Viewing your browsing history
Under the History heading, you can view the twenty most recent DocuShare pages you 
have visited while logged into DocuShare. Each page is linked, allowing you to click it to 
go to that page. Your browsing history restarts each time you log into DocuShare.

Viewing your routing tasks
All of the routing tasks assigned to you are listed under the Tasks heading. This provides 
you with a quick view of the tasks to which you need to respond. You can click a task to 
open its window.

In addition, clicking the Tasks heading displays the My Tasks window. You can view both 
the tasks assigned to you and the tasks you assigned, and your routing task history in this 
window. For more information on document routing, see Routing documents.
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Routing documents
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About routing documents
During a document’s development cycle, you often need to solicit feedback from others, 
receive approval of the document’s content, or simply share the information in the 
document. DocuShare enables you to automate the routing of documents to users and 
request a specific action after the users receive the documents.

On a form called a Routing Slip, you indicate the users to whom the document should be 
sent, the type of action you want the users to take, and a message describing the 
document task. You then submit the Routing Slip; DocuShare notifies the specified users 
of the document task. While a task is in progress, you can monitor its status.
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Routing a document
You can route a document that is stored in a collection on your site or you can choose to 
route a document when adding it to a collection. In addition, you can route an individual 
document version. On the Routing Slip that accompanies the document, you can request 
users to approve the document, review the document and provide changes, or 
acknowledge receipt of the document, or you can provide the document for information 
only.

When creating a routing task, you can define a single routing step or several sequential 
steps. A single routing step consists of one type of action, such as sending a document to 
users for approval. A multi-step routing task enables you to automate a document 
process. For example, you can create a routing task to send a document to a group of 
users for their review and comment before sending the revised document for approval.

Routing a document
You can route a document that is stored in a collection or you can choose to route a 
document immediately after adding it to a collection.

To route a document:

1. Do one of the following:

• Locate the document or document version that you want to route. Click the 
Route icon that appears to the right of the document’s title. A Route icon 
does not appear if the document is locked

• In a collection, select Document from the Add menu. Enter the required 
information and click Publish and then route the document before clicking 
Apply.

The Route Document window appears.

2. If you want to use a saved Routing Slip, do one of the following and then go to 
step 17: 

• Select one of your saved Routing Slips and click Load.

• Click All Saved Routing Slips to display the public Routing Slips saved by all 
site users. Select a Routing Slip.

3. Under Routing Action, choose one of the following:

• Approve or Disapprove—Requires users to approve or not approve the 
document.

• Review and Make Changes—Allows users to provide comments and a 
revised version of the document. Click Share Changes with Recipients if 
you want each recipient to see the previous recipient’s changes.

• Acknowledge Receipt—Provides the document to users for information and 
requires the users to confirm receiving the document.

• Information—Provides the document to users for information only.
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4. Depending on the routing action you selected, choose one of the following 
Routing Orders:

• In Order—Routes the document to users in the order in which they are listed 
in the Selected Users/Groups field. If a user does not approve the 
document, it is not routed to subsequent users.

• At the Same Time-Single Reply—Routes the document to all users 
simultaneously and only one user’s reply is needed to complete the routing 
task.

• At the Same Time-All Reply—Routes the document to all users 
simultaneously and all users must reply to complete the routing task.

• At the Same Time-Majority Reply—Routes the document to all users 
simultaneously and more than half of the users must reply to complete the 
routing task.

5. Under Message, do the following:

• In the Subject field, enter a brief topic that appears in the notification or email 
that the user receives.

• In the Comments field, enter a message.

6. Click Next to go to the Add Recipients page.

7. In the Show field, select the type of account you want to display in the Possible 
Users/Groups field.

8. To find a specific account, enter part of the user’s first name, last name, or 
username or the group’s title in the Search field. Click the Go button.

9. In the Possible Users/Groups field, select the accounts to add to the list of 
recipients and click the Add button. To select multiple accounts, use the CTRL 
key (Windows) or the Command key (Macintosh).

10. In the Selected Users/Groups field, select any accounts that you want to remove 
from the list of recipients and click the Remove button.

11. To show the members in a group, select the group in the Selected Users/Groups 
field and click Show Group Members. The group members replace the group title 
and the routing task is sent to each user and not to the group.

12. To reorder the recipients in the Selected Users/Groups field, select an account 
and do one of the following:

• To move the recipient before another recipient, click Move Up.

• To move the recipient after another recipient, click Move Down.

13. Click Next to go to the Choose Escalation and Notification page.

14. Under Escalation, choose any of the following:

• If Not Completed By—Specifies a completion date for the routing task. Either 
enter a date in the field or click the Calendar icon and select a date.

• Then Escalate—If the routing task is not complete by the specified date, 
choose the type of action you want to take.
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15. Under Notify Me, choose any of the following:

• Of Escalation—Notifies you of the escalation action.

• Of Task Progress—Notifies you of the routing status after each user action.

• When Task Is Complete—Notifies you when each routing step is complete.

To check for notifications, click the My Tasks link on the navigation bar and select 
Tasks Assigned to Me.

16. Click Done to go to the Routing Summary page.

17. Review the routing information for the task and then do one of the following:

• Click Submit to start the routing task.

• Click Back to change any of the routing information.

• Click Add Step to add another step to the routing task.

NOTE: Before submitting the routing task, you can save the Routing Slip. Click Save 
Routing Slip. Enter a name for the Routing Slip and keep Save as private 
selected if you do not want to share the Routing Slip with other users. Then click 
OK.

Routing a document before adding it to a collection
When routing a document from the Add Document page, you can choose to route the 
document before adding it to the collection. When the routing task is complete, you must 
publish the document to add it to the collection. For information on how to publish the 
document, see Checking the status of routing tasks you assigned on page 12–7.

To route a new document:

1. Navigate to and open the collection to which you want to add a document.

2. From the Add menu, select Document.

The Add Document page appears.

3. Enter the required and any optional information.

4. For Document Routing, select Route the document and publish it later.

5. Click the Apply button.

The Route Document window appears. 

6. Follow steps 2 through 17 in Routing a document on page 12–3.

NOTE: If the type of routing task requires a recipient to be added to the access list, 
DocuShare will display two messages on the Routing Summary page: one 
message refers to the document and the other refers to the document version.
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Adding documents to the Routing Slip
Before submitting a Routing Slip, you can include additional documents to be routed. You 
can add a document from a collection and from the Add Document page.

To add a document to a Routing Slip:

1. Do one of the following:

• Navigate to the collection that contains another document that you want to 
route and click the document’s Route icon.

• In an Add Document window, enter the document filename and title, and then 
select either Route the document and publish it later or Publish and then 
route the document.

2. In the confirmation window, click OK.

The document you added appears on the Routing Slip’s Routing Summary page. 
On the Routing Summary page, you can remove a document from the Routing 
Slip by selecting the document and clicking the Remove button.
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Checking the status of routing tasks you 
assigned
You can check the status of completed and pending routing tasks that you assigned to 
other users. Once a task is complete, you can choose to delete it, keep a record of it, or 
publish the document to add it to the collection.

To check the status of a routing task:

1. Do one of the following:

• On the navigation bar, click My Tasks.

• On the navigation bar, click My DocuShare. The click Tasks.

The My Tasks window appears.

2. From the Show menu, select Tasks Assigned by Me.

The page lists the routing tasks, under Description, the date the task began, and 
the status. Table 12–1 describes the status information.

Table 12–1: Task status

Status Description

Approved The single-step task or one step of a multi-step task is 
complete and the recipient(s) approved the document(s).

Disapproved The single-step task or one step of a multi-step task is 
complete and the recipient(s) did not approve the 
document(s).

Reviewed The single-step task or one step of a multi-step task is 
complete and the recipient(s) reviewed the document(s).

Acknowledged The single-step task or one step of a multi-step task is 
complete and the recipient(s) acknowledged receiving the 
document(s).

Delivered The single-step task or one step of a multi-step task is 
complete and the recipient(s) received the document(s) for 
their information.

All Steps Completed The multi-step task is complete.

Started The task is pending. It is currently being routed to all 
recipients at the same time for approval, review, or 
acknowledgement.

Username The task is pending. It is currently being routed to all 
recipients in order; the user whose name is displayed has 
received the document, but has not taken any action.

Step # The task is pending and is on a specific step of a multi-
step task.
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3. To view more information about the task, click the task’s description.

A Report on Routing window appears, which shows the status of each user 
assigned the task.

4. Do one of the following:

• To view an individual recipient’s comments, click the user’s name.

• To view all recipient comments, click Show all User Comments. If you want, 
you can save the comments to a text file. 

Close the window after viewing the comments.

5. To view the user’s changes to the document, click the document’s title.

6. Close the document after viewing the changes. Then close the Response to 
Routing window.

7. If the task is complete, do one of the following:

• To move a task from the Tasks Assigned by Me list to your Deleted Tasks, 
click Delete This Job.

• To complete the task later, click Keep for Later. The task remains in the 
Tasks Assigned by Me list.

• To publish a document that has not been added to a collection (the word 
Unpublished appears after the document’s title), click the Properties icon that 
appears to the right of the document’s title. At the bottom of the Properties 
page, click the Publish This Version button.

Viewing progress reports
If you chose to be notified of a task’s progress, completion, or overdue status on the 
Routing Slip, you can view the notifications in the Routing Tasks window. 

To view a task’s progress report:

1. Do one of the following:

• On the navigation bar, click My Tasks.

• On the navigation bar, click My DocuShare. The click Tasks.

Step #: Username The task is pending and is on a specific step of a multi-
step task. It is currently being routed to all recipients in 
order; the user whose name is displayed has received the 
document, but has not taken any action.

Overdue For a single-step task or one step of a multi-step task that 
is overdue, the word Overdue appears after the task’s 
description.

Terminated The task is stopped because it cannot continue. This can 
occur when Cancel Task is set for Then Escalate or when 
a document or user is deleted from your site.

Table 12–1: Task status

Status Description
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The My Tasks window appears.

2. From the Show menu, select Tasks Assigned to Me.

The page lists the routing tasks, under Description, the date the task was 
assigned, and the type of report. Table 12–2 describes the report types.

3. To view a task’s progress report, click its Description. 

A Response to Routing window appears, which includes the routed document and 
shows the user’s comments.

4. To view the user’s changes to the document, click the document’s title.

You can save the user’s revised document as a new version of your routed 
document. See the next section, Publishing a new version of your routed 
document on page 12–9.

5. Close the document after viewing the changes.

6. In the Response to Routing window, do one of the following:

• To schedule a new due date for an overdue task, enter a new date in the Due 
Date field and click the Acknowledged button.

• To confirm reviewing the report, click the Acknowledged button.

• To review the report at a later time, click the Acknowledge Later button.

Publishing a new version of your routed document
If you routed a document for review, you can save a document that a recipient changed as 
a new version of your routed document. In the For Your Review window, the word New 
appears after the title of a document that a recipient changed.

To publish a new version of your routed document:

1. In the My Tasks window, select Tasks Assigned by Me.

2. Under Description, click the task that includes the changed document.

3. In the Report on Routing for Review window, click the name of the recipient who 
provided the changed document.

4. Click the document title to open it.

5. Save the document to a location on your computer, and then close the document 
window.

6. In the Report on Routing for Review window, click the Close button.

Table 12–2: Report type

Type Description

Response The recipient responded to the task.

Completion The task is complete.

Overdue The task is in progress past the completion date.

Termination The task is stopped because it cannot continue. This can 
occur when a document or user is deleted from your site.
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7. Click the Properties icon that appears to the right of the document’s title.

8. At the bottom of the Properties page, click the Publish New Version button.

9. On the Add Version page, click the Browse button.

10. Navigate to the location on your local drive in which you saved the document in 
step 5, select it, and click Open.

The path to the document appears in the Filename field.

11. Optionally, change the document title and add a version comment.

12. Click Apply.

13. If a document version other than the latest is the preferred version, you are asked 
if you would like to set this version as the preferred version. Click Yes to change 
the preferred version; otherwise, click No.

For more information on document versions and the preferred version, see 
Managing document versions on page 4–12.

14. Click the Report on Routing for Review link in the Location path.

15. In the Report on Routing for Review window, do one of the following:

• To move the task from the Tasks Assigned by Me list to your Deleted Tasks, 
click Delete This Job

• To remove the task later, click Keep for Later. The task remains in the Tasks 
Assigned by Me list.
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Viewing the tasks assigned to you
The tasks assigned to you display in the My Tasks window or on My DocuShare. If you 
chose to receive an email message when a new task is assigned to you, the message 
includes a URL to the task.

NOTE: To receive an email message when a new task is assigned to you, your user 
account property Routing Task Notification must be set to Email and your 
email address must appear in the Email Address field.

To view the tasks assigned to you:

1. Do one of the following:

• On the navigation bar, click My Tasks. From the Show menu, select Tasks 
Assigned to Me. Any task marked Request is a task assigned to you.

• On the navigation bar, click My DocuShare. The tasks assigned to you 
display under Tasks.

2. Click a task to view it.

A window appears displaying your task. The following sections describe how to 
respond to routing tasks.

Approving or disapproving a document
1. In the For Your Approval window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

NOTE: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. Review the document.

3. When your review is complete, close the document.

4. You can repeat steps 1 through 3 for each routed document.

5. In the Comments field, enter an optional message.

6. Click Save as private if you do not want other recipients to view your comments.
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7. Do one of the following:

• To complete the task and approve the document, click the Approved button. 
The task is removed from the Tasks Assigned to Me list.

• To complete the task but not approve the document, click the Disapproved 
button. The task is removed from the Tasks Assigned to Me list.

• To not complete the task at this time, click the Respond Later button. The 
task remains in the Tasks Assigned to Me list.

Reviewing a document
1. In the For Your Review window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

NOTE: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. Review the document and make any changes you want.

3. Close the document and, if you made changes, save it to a location on your 
computer.

4. If you changed the document, do the following:

a. Click the Properties icon that appears to the right of the document’s title.
b. At the bottom of the Properties page, click the Add Draft Version button.
c. On the Add Version page, click the Browse button.
d. Navigate to and select the document you changed, and then click Open.
e. Optionally, change the document title and add a version comment.
f. On the Add Version page, click Apply.
g. If a document version other than the latest is the preferred version, you are 

asked if you would like to set this version as the preferred version. Click Yes 
to change the preferred version; otherwise, click No.

h. On the Properties page, click the For Your Review link in the Location path.
5. You can repeat steps 1 through 4 for each routed document.

6. In the Comments field, enter an optional message.

7. Click Save as private if you do not want other recipients to view your comments.

8. Do one of the following:

• To complete the task and remove it from the Tasks Assigned to Me list, click 
the Reviewed button.

• To not complete the task at this time, click the Review Later button. The task 
remains in the Tasks Assigned to Me list.
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Acknowledging receipt of a document
1. In the For Your Acknowledgement window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

NOTE: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:

• To complete the task and remove it from the Tasks Assigned to Me list, click 
the Acknowledged button.

• To not complete the task at this time, click the Acknowledge Later button. 
The task remains in the Tasks Assigned to Me list.

Removing a document sent for information
1. In the For Your Information window, click the document’s title.

The document opens in its native editor or a window appears allowing you to 
download the document.

NOTE: If the document version sent to you is not the latest version, a Latest published 
version link is included. You can click the link to view the latest version of the 
document.

2. When you are finished viewing the document, close it.

3. You can repeat steps 1 and 2 for each routed document.

4. Do one of the following:

• To complete the task and remove it from the Tasks Assigned to Me list, click 
the Remove button.

• To not complete the task at this time, click the Remove Later button. The task 
remains in the Tasks Assigned to Me list.
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Viewing your deleted tasks
After you delete a completed task that you assigned by clicking the Delete This Job 
button, DocuShare saves the task in your Deleted Tasks. This provides you with a record 
of the completed routing tasks you assigned.

To view your deleted tasks:

1. Do one of the following:

• On the navigation bar, click My Tasks.

• On the navigation bar, click My DocuShare. The click Tasks.

The My Tasks window appears.

2. From the Show menu, select Deleted Tasks.

Your deleted routing tasks display.
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Viewing the current routing tasks of a 
document
The routing task owner and each recipient can view the routing status of a document or 
any of its versions on the Properties page for the document.

To view a document’s routing tasks:

1. Do one of the following:

• Open the collection that contains the document whose tasks you want to view.

• Open a routing report or request window that contains the document whose 
tasks you want to view.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.

3. Click the Routing tab.

The tasks and their status display.
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About scanning documents
If you have access to a Xerox WorkCentre with the Scan to File feature enabled, you can 
scan documents to DocuShare. The WorkCentre converts your printed documents to TIFF 
format and stores the digital documents in a temporary collection on your DocuShare 
server. You can save your scanned documents to a permanent collection on your site.
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Scanning a document at a WorkCentre
Your WorkCentre administrator must set up a scan template before you can scan 
documents to DocuShare. When setting up a scan template, the administrator can choose 
to save each document page to a TIFF file or to save all of the document pages to a single 
TIFF file. Check with your administrator to find out which template you should use and 
whether or not a password is required.

NOTE: Depending on which WorkCentre model you use, the steps for scanning a 
document can vary. DocuShare does not support scanning color images on a 
WorkCentre Pro 40 using JPEG compression (JPEG-in-TIFF).

To scan a document:

1. Place a document on the document glass or in the document feeder.

2. Press the Features button.

3. On the touch screen, press the Scan tab.

4. Press Scan to File.

5. Select the scan template.

6. If the template requires a password, do the following:

a. Press Added Features.
b. Press Filing Setups.
c. Press Login Name/Password.
d. Press Password.
e. Type your password and press Save.
f. Press Save.

7. Press the Start button.

The WorkCentre scans the document and then sends it to the temporary scan collection 
on your DocuShare server. The document is stored in this collection for a designated time 
period. You can check the time period by clicking WorkCentre Scans on the DocuShare 
home page. To keep the document, you need to save it to a permanent collection.
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Saving a scanned document to a collection
To save a scanned document to a collection, you must be logged in and have Writer 
access to the collection.

To save a scanned document to a collection:

1. Go to the DocuShare home page.

2. Under Related Links, click WorkCentre Scans.

3. If the Passcode field appears, enter the password you entered at the WorkCentre 
to scan the document and then click Enter Passcode.

4. Locate your scanned document.

5. Click Save.

If you do not want to save the document to a collection, click Delete to remove the 
document from the temporary scan repository.

6. If you want to rotate the document, select the number of degrees from the Rotate 
Image menu and click Go.

7. From the Document Type menu, select the type of document to save the 
scanned document as.

The menu contains types in addition to Document if your administrator created 
custom documents on your site.

8. If your administrator specified a default collection in which to save scanned 
documents, its title appears in the Destination field. Do one of the following:

• If you want to use the default collection, go to step 13.

• If you want to change the collection, click Select. The Select Destination page 
appears.

9. In the Sort By field, select Name to display the collections in alphabetical order or 
select Handle to display the collections in numerical order.

10. Do one of the following:

• To find specific collections, enter one or more words in the Search field. Click 
the Go button.

• To display all collections, click Show All.

• To display your favorite collections, click Show Favorites.

• To display your personal collection, click Show Personal Collection.

11. In the Possible Locations field, select the collection to which you want to save 
the document.

12. Click Apply.

13. In the Title field, enter a title for the document.

14. Enter any additional information. Click a field name for a description of each 
property.
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15. Click Save.

The document is saved to the collection you specified.

NOTE: Your administrator may have given you access to a collection named 
Temporary Scan Repository. Alternatively, you can open this collection to 
move or delete your scanned document.
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About archiving content
The DocuShare Archive Server enables your organization to conveniently increase 
document storage capacity while providing a safe location for archived content. If your site 
includes an Archive Server, you can move content from your collections to a secondary 
server. When you need to retrieve your archived content, you can search for the object 
and, if needed, restore it to a collection.

Check with your DocuShare administrator to find out if your site uses an Archive Server.
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Archiving content
You can archive documents, Interact pages, and mail messages with attachments. When 
you archive a document, all of its versions also are archived. To quickly archive the 
contents of a collection, you can select the collection and archive it. However, only the 
documents, Interact pages, and mail messages in the collection and its subcollections are 
archived; the collection is not archived and remains on the DocuShare server.

There are two ways to archive content: Specify a date on which to have objects archived 
automatically, or select the objects you want to archive and use the Archive command. 
After an object is archived, it retains its properties, access list, and previous location on the 
DocuShare server.

You can archive an object if you are the logged-in owner of the object or a logged-in user 
with Manager access to it.

Archiving content automatically
By default, DocuShare uses the object's Expiration Date property to archive content 
automatically. Your DocuShare administrator can specify a different date property to use 
for archiving, so check with your administrator to find out which property you should use.

To archive content automatically:

1. Locate the object (document, Interact page, mail message) that you want to 
archive.

2. Click the Properties icon that appears to the right of the object’s title.

3. Click the Edit tab.

4. In the appropriate date field, enter the date on which you want the object archived.

5. Click Apply.

DocuShare archives the object on the date you specified.

Archiving content manually
To archive content manually:

1. Do one of the following:

• Navigate to and open the collection that contains the objects you want to 
archive.

• Run a search to find the objects you want to archive.

• Navigate to the collection that contains the objects you want to archive.

2. Do one of the following:

• To archive objects in an open collection or from a search, click the checkbox 
that appears next to the title of each object.

• To archive the contents of a collection, click the checkbox that appears next to 
the title of the collection.

3. From the Edit Selected menu, select Archive.

The Confirm Move to Archive page appears.
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NOTE: If a minus sign appears in the checkbox that precedes an object, then you do 
not have Manager access to the object and cannot archive it.

4. Click the Confirm button to move the objects to the Archive Server.

If you do not want to archive the objects, click Cancel.
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Restoring archived content
You can restore any object that you moved to the Archive Server to its previous location 
on DocuShare. If the DocuShare collection in which the object was located was deleted, 
you can add the object to another collection after restoring it. An object is restored with its 
associated properties and access list. However, if a user who previously appeared in the 
object’s access list was deleted from the DocuShare site, the user will not appear in the 
restored object’s access list. Also, if you are restoring an object that was owned by 
another user whose DocuShare account was deleted, you will become the new owner.

You can restore an object if you are the logged-in owner of the object or a logged-in user 
with Manager access to it.

To restore an archived object:

1. On the home page or a collection page, click the Advanced link.

The Advanced Search page displays.

2. If you are running the search from a collection, select the search scope in the 
Search Within field.

NOTE: The search scope you select is used on the Archive Server. When an object is 
archived, it retains its original location path. If you know any part of the object’s 
location path, you can narrow the search scope to speed the search.

3. In the Server to Search field, select Archive Server.

4. Specify the search terms and options you want.

5. Click Search.

The Search Results page displays. The words Appeared In followed by the 
collection name display under each object whose collection exists on DocuShare. 
If Appeared In and the collection name do not display, then the object’s collection 
was deleted. You can restore the object as an orphan and then add it to another 
collection.

6. Select the objects to restore.

7. From the Edit Selected menu, select Restore.

8. On the Confirm Restore From Archive page, click Confirm.

The Archive Restore Results page displays.

9. If the object is an orphan, do the following:

a. Click the checkbox that precedes it.
b. From the Edit Selected menu, select Change Location.
c. On the Confirm Change Location page, click Confirm.
d. Use the Change Location page to relocate the orphaned object.
The Archive Restore Results page displays and lists the new collection in which 
the object appears under the object’s title.
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Answers to frequently asked questions 
This section provides answers to some frequently asked questions about DocuShare. 

Table 15–1: FAQs

Problem Solution

Why am I unable to create an account 
on DocuShare?

Your administrator may have restricted 
account creation to either registered users or 
an administrator. Check with your DocuShare 
administrator.

Why am I unable to log into 
DocuShare?

Make sure you are using a browser that 
supports logging into a system. Check with 
your DocuShare administrator to find out 
which browsers support logging. Also, make 
sure your browser is set to accept cookies.

This problem can also occur when your 
browser is not set to refresh the page with 
every visit to it. In this case, you are actually 
logged in, but are seeing an out-of-date page.

I forgot my DocuShare username. 
What should I do?

On the navigation bar, click the Users & 
Groups link. On the List page click Show All 
to display all the users on your site. Locate 
and then click your name. The Username 
field on the Properties page displays your 
username.

I forgot my DocuShare password. 
What should I do?

Do not create another user account. Contact 
your DocuShare administrator, who can set 
another password for you.

Why does a newly added object not 
display when I search for it?

After adding an object to your site, wait a few 
seconds before searching for it as DocuShare 
needs to finish indexing the object and its 
properties.

Why does DocuShare find objects 
that contain a property value I did not 
specify?

When a property is assigned several comma-
separated values, DocuShare treats the 
comma like a space. Therefore, DocuShare 
will find objects that contain adjacent property 
values.

For example, if a document’s Author property 
value is Susan George, Taylor Jones, 
DocuShare will find the document if you 
search for Author or Any Part contains Susan 
George, Taylor Jones, or George Taylor.
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Why does Netscape Navigator hang 
when I try to upload a document to 
DocuShare?

Check to see if the document is open in its 
associated application (for example, Word or 
PowerPoint). If it is, close the document and 
try the upload again. (This is a suspected bug 
in the Netscape-Windows interaction.)

Why am I unable to see a document I 
uploaded to DocuShare? I did not 
have any problems during the upload.

Check your browser's proxy settings. You 
should not be using a proxy server to access 
your DocuShare server.

I uploaded a document to DocuShare 
and received an error saying it had an 
invalid index or was unable to open 
the collection. What should I do?

If you return to the collection to which the 
document was added, you should find that it 
was correctly uploaded. If so, the problem was 
with the search indexing step that occurs after 
your document has been uploaded. The 
document is stored but not indexed. Report 
the problem to your administrator.

When I click the title of a document in 
DocuShare, I get the message 
“Unknown File Type - You have 
started to download a file of type 
application/....” What should I do?

Make sure your browser is configured to use a 
helper application to view this type of 
document.

I am using Internet Explorer. When I 
click a PDF document in DocuShare, I 
just get a blank page. Why does the 
file not open?

This is a known interaction problem between 
Internet Explorer and Acrobat (PDF) files. 
Contact your administrator for help.

Why does the page does not display 
properly after I add HTML tags to the 
object's properties?

DocuShare allows you to add HTML tags to 
text-based properties such as an object's 
Description or Summary. You should limit use 
of HTML to simple formatting commands like 
font changes and lists. Including header 
commands like <HTML>, <HEAD>, or 
<BODY> will most likely interfere with 
DocuShare's own HTML commands, leaving a 
page that is either blank or very poorly 
formatted. You should also avoid using any 
tags in Title and Summary properties that 
affects the vertical layout, such as IMG and list 
directives, because those two properties are 
displayed in contexts that assume simple 
strings.

What should I do if I cannot find an 
object or a document?

DocuShare provides a variety of search 
features to help you quickly find objects. See 
DocuShare searches for information on how 
to run a search.

Table 15–1: FAQs

Problem Solution
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I am logged into DocuShare and 
when I try to access an object, I 
receive a message that says "Not 
Authorized.” What should I do?

Contact the object’s owner, who can give you 
access. 

I accidentally deleted a collection 
without deleting the objects it 
contained. Now I cannot find those 
objects. What should I do?

When you delete a collection, but not its 
contents, and the objects are not located in 
another collection, they become orphaned. 
You are unable to access orphaned objects 
from a collection. However, the objects are 
still stored on your site. Your administrator can 
relocate orphaned objects in a collection so 
you can access them again. Or, you can 
access an orphaned object if you know its 
unique address (for example, http://
sales.acme.com/docushare/dsweb/Get/
Document-128).

After moving a collection to a new 
location, why am I unable to find it in 
either the new or the old location?

You accidentally orphaned the collection, 
which means you cannot access it from 
another collection. The collection is still stored 
in DocuShare. Your administrator can recover 
the orphaned collection by relocating it in a 
collection. Or, you can access the collection if 
you know its unique address (for example, 
http://sales.acme.com/docushare/dsweb/Get/
Collection-12).

I deleted an object from a collection. 
Why can I still see it when I navigate 
to the collection page?

If you used the browser’s Back button, 
Favorites, or Bookmarks to navigate, you may 
have accessed a cached version of the 
collection page. Click the browser’s Refresh or 
Reload button to display the latest version of 
the page.

I logged into DocuShare, navigated 
the site, and then used my browser’s 
Back button a few times. Why am I 
now logged in as a Guest?

You have accessed a cached version of the 
page. Click the browser’s Refresh or Reload 
button to display the latest version of the 
page. You should see your username on the 
navigation bar.

I use Netscape Navigator to access 
DocuShare. After rotating a scanned 
image, why does it not appear 
rotated?

You need to change the browser’s cache 
setting. Open the Preferences window, and 
click Advanced then Cache. Under Compare 
the page in the cache to the page on the 
network, select Everytime I view the page.

Table 15–1: FAQs

Problem Solution
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Why can changing the permissions of 
a collection and its objects take longer 
than expected or time out?

The time it takes to change the permissions of 
a collection and its objects is dependent on 
the number of collection objects, which 
includes all nested collections and their 
contents. When changing the collection’s 
permissions, DocuShare must examine each 
object’s access list and either merge the 
changes or replace the access list. It is 
important to note that even if your browser 
times out, DocuShare is processing and will 
complete the permissions change.

As an alternative, your administrator can use 
a command line utility to change the 
permissions of a collection that contains a 
large number of objects. 

Table 15–1: FAQs

Problem Solution
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Using WebDAV folders
DocuShare supports the WebDAV (Web Distributed Authoring and Versioning) protocol, 
which enables you to access DocuShare collections and documents through a WebDAV-
compliant folder. You do not need client software installed on your computer. If you are a 
Windows 2000 or XP user, simply go to My Network Places to add a DocuShare server 
as a network place. If you are using a Macintosh with OS X, select Connect to Server to 
add the URL for a DocuShare server.

NOTE: In both Windows and OS X, you must append the DocuShare server's URL with 
/webdav. When you are prompted to log in, use your DocuShare username and 
password.

Document titles in WebDAV folders
Your DocuShare administrator controls how document titles are displayed in collections. 
For example, a title might have a file extension appended to it. If you have any questions 
about how document titles are displayed, see your administrator.
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restoring after deleting 6–9
viewing properties 6–5

calendar event, See event
calendar view

changing 6–4
day view 6–2
month view 6–2
week view 6–2

Change Location (Edit Selected menu) 3–7
Change Owner (Edit Selected menu) 3–7
changing location

calendar 6–6
collection 3–5
discussion 7–5
document 4–5
event 6–13
saved query 10–10
topic 7–12
URL 8–5

changing properties
calendar 6–5
collection 3–4
discussion 7–4
document 4–4
event 6–11
group account 2–8
reply 7–10
saved query 10–9
subscription 9–5
topic 7–10
URL 8–4
user account 2–4
version 4–13

checking in an edited document 4–9
checking out a document 4–9
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collection 3–2
See also personal collection
about 1–5
adding 3–3
adding document to 4–3
applying permissions to contents 5–6
changing access permissions 5–4
changing its location 3–5
changing owner 5–5
changing properties 3–4
deleting 3–8
editing multiple objects in 3–7
restoring after deleting 3–9
viewing properties 3–4

Content Administrators 5–3
Content Map link 1–4
Copy (Edit Selected menu) 3–7
creating

group account 2–7 to 2–8
user account 2–3

D
day view, calendar 6–2
Delete (Edit Selected menu) 3–7
deleted tasks, viewing 12–14
deleting

calendar 6–8
collection 3–8
completed routing tasks you assigned 

12–8
discussion 7–7
document 4–17
event 6–12
expired topics 7–13
group account 2–12
reply 7–11
saved query 10–12
subscription 9–7
topic 7–11
URL 8–7
user account 2–5

discussion
about 7–2
adding to a collection 7–3
applying permissions to contents 5–6
changing access permissions 5–4
changing its location 7–5
changing owner 5–5

changing properties 7–4
deleting 7–7
restoring after deleting 7–8
setting expiration date for topics 7–3
viewing properties 7–4

document
about 4–2
adding new version of existing 4–11
adding to collection 4–3
applying permissions to versions 5–7
archiving 14–3 to 14–4
changing access permissions 5–4
changing its location 4–5
changing owner 5–5
changing properties 4–4
checking in new version 4–9
checking out 4–9
deleting 4–17
downloading 4–16
editing 4–9
locking 4–14
restoring after deleting 4–18
restoring from Archive Server 14–5
routing to users 12–3 to 12–5
saving scanned document to a 

collection 13–4
scanning at a WorkCentre 13–3
unlocking 4–15
viewing 4–7
viewing in HTML format 4–8
viewing its version history 4–12
viewing properties 4–4
viewing routing tasks in progress 12–

15
DocuShare 1–2

accessing 1–3
and WebDAV folders A–2
FAQs 15–2 to 15–5
icons 1–5
logging in 1–9
logging out 1–9
navigating 1–4

DocuShare Archive Server 14–2
DocuShare client applications

DocuShare Outlook Client 1–10
DocuShare Windows Client 1–10

DocuShare Interact 1–10
DocuShare objects, See objects
DocuShare Outlook Client 1–10
DocuShare Windows Client 1–10
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domain
changing for group 2–11
changing for user 2–5

downloading a document 4–16

E
Edit Selected menu 3–7
editing a document 4–9
email message

receiving when routing task is assigned 
12–11

sending to a group 2–11
event

See also recurring event
adding to calendar 6–10
changing access permissions 5–4
changing its location 6–13
changing owner 5–5
changing properties 6–11
deleting 6–12
viewing properties 6–11

expired topic
deleting 7–13
viewing 7–13

F
FAQs 15–2 to 15–5
favorites

adding objects to 11–3
removing objects from 11–3
viewing 11–3

frequently asked questions, See FAQs

G
group account

changing domain 2–11
changing group members 2–9
changing group owner 2–10
changing properties 2–8
creating 2–7 to 2–8
deleting 2–12
searching for 2–13
sending email to members 2–11

viewing list of 2–13
viewing properties 2–8

guest user 2–3
viewing what’s new on DocuShare 1–8

H
Help link 1–4
Home link 1–4
home page 1–3

features 1–3
HTML format, viewing a document in 4–8

I
icons, for objects 1–5
initial permissions, setting for objects 6–10

L
LDAP (Lightweight Directory Access 

Protocol)
and user accounts 2–2
changing group domain 2–11
changing user domain 2–6
changing user password 2–5
changing username 2–5

locking a document 4–14
logging in 1–9
logging out 1–9
logical operators

types 10–5
using in searches 10–4 to 10–5

Logout link 1–4

M
Manager access permission 1–6, 5–2
members

changing for group 2–9
sending email to group 2–11

month view, calendar 6–2
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My DocuShare
about 1–7, 11–2
link 1–4
viewing browsing history 11–6
viewing favorites 11–3
viewing personal calendar 11–5
viewing personal collection 11–4
viewing routing tasks 11–6

My Tasks
link 1–4
using to check tasks you assigned 12–

7
using to view progress reports 12–9, 

12–14
using to view tasks assigned to you 

12–11

N
navigating DocuShare 1–4
navigation bar 1–4
nonalphanumeric characters, using in 

searches 10–7

O
object properties 1–6
objects

See also calendar, collection, 
discussion, document, event, 
group account, saved query, topic, 
URL, user account

about 1–5
changing access permissions 5–4
changing owner 5–5
editing multiple in collection 3–7
icons 1–5
searching for 10–3 to 10–5

owner
changing for group 2–10
changing for object 5–5

P
password, changing 2–5
Paste (Edit Selected menu) 3–7
permissions, See access permissions

personal calendar 11–5
creating 11–5

personal collection 11–4
adding objects to 11–4

preferred version
and maximum versions 4–3
changing 4–12
defined 4–12

progress reports, viewing 12–8 to 12–9
properties, and objects 1–6

Q
question mark, using in searches 10–7

R
Reader access permission 1–6, 5–2
recipient list

changing for document routing 12–4
creating for subscription 9–6

recurring event
adding to calendar 6–10
deleting series of 6–12

Rename (Edit Selected menu) 3–7
rendition

viewing for versions 4–13
viewing HTML 4–8

reply
adding to topic 7–9
changing properties 7–10
deleting 7–11
viewing properties 7–10

reserved characters, using in searches 10–
7

restoring archived content 14–5
restoring deleted objects 3–9, 4–18, 6–9, 

7–8, 8–8, 9–8, 10–13
retain login for future 1–9
routed document

acknowledging receipt of 12–13
approving 12–11
disapproving 12–11
publishing new version of 12–9
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removing after sent for information 12–
13

reviewing 12–12
routing a document

about 12–2
including additional documents 12–6
routing order 12–4
to users 12–3 to 12–5
types of routing tasks 12–3
using a saved Routing Slip 12–3

Routing Slip 12–2
re-using 12–3
saving 12–5

routing tasks
checking status of your tasks 12–7 to 

12–8
deleting completed 12–8
viewing deleted 12–14
viewing for document 12–15
viewing tasks assigned to you 11–6, 

12–11

S
saved query

adding to collection 10–8
changing access permissions 5–4
changing its location 10–10
changing owner 5–5
changing properties 10–9
restoring after deleting 10–13

saved Routing Slip, using 12–3
saving

a Routing Slip 12–5
scanned document to a collection 13–4
search query 10–8

scan template 13–3
scanned document

checking length of time in temporary 
collection 13–3

receiving URL after saving 13–4
saving to a collection 13–4

scanning documents
about 13–2
at a WorkCentre 13–3

Search Available to, defined 5–4

searches 10–2
See also saved query
running 10–3 to 10–5
saving 10–8
using nonalphanumeric characters 10–

7
using wildcards 10–7

searching for objects 10–3 to 10–5
combining search terms 10–4 to 10–5
finding user and group accounts 2–13
running a word search 10–3
using search options 10–3

snippet (document), showing and hiding in 
search results 10–3, 10–5

stemming 10–2
subscription

about 9–2
adding 9–3
changing properties 9–5
creating a recipient list for 9–6
deleting 9–7
events of interest 9–2
notification time periods 9–3
requirements for using 9–2
restoring deleted 9–8
viewing 9–4
viewing properties 9–5

T
tasks, See routing tasks
temporary scan collection

checking how long scanned 
documents are stored 13–3

moving scanned document from 13–4
TIFF file, creating by scanning 13–3
topic

adding to discussion 7–9
changing access permissions 5–4
changing its location 7–12
changing owner 5–5
changing properties 7–10
deleting 7–11
deleting expired 7–13
replying to 7–9
viewing expired 7–13
viewing properties 7–10
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U
unlocking a document 4–15
uploading a document 4–3
URL

about 8–2
adding to collection 8–3
changing access permissions 5–4
changing its location 8–5
changing owner 5–5
changing properties 8–4
deleting 8–7
restoring after deleting 8–8
viewing properties 8–4

user account
changing domain 2–5
changing password 2–5
changing properties 2–4
changing username 2–5
creating 2–3
deleting 2–5
searching for 2–13
viewing list of 2–13
viewing properties 2–4

username, changing 2–5
Users & Groups link 1–4

V
version comments, adding 4–9, 4–11
version history, viewing 4–12
version, document

adding edited document 4–9
adding new document 4–11
changing preferred version 4–12
changing properties 4–13
publishing routed document 12–9
specifying maximum to save 4–3
viewing 4–12
viewing properties 4–13
viewing renditions 4–13

viewing
a document 4–7
a document in HTML format 4–8
access permissions 5–3
document version history 4–12
expired topics 7–13
new content 1–8

progress reports for routing tasks 12–8 
to 12–9

version renditions 4–13
viewing properties

calendar 6–5
collection 3–4
discussion 7–4
document 4–4
event 6–11
group account 2–8
reply 7–10
subscription 9–5
topic 7–10
URL 8–4
user account 2–4

W
WebDAV folder, using with DocuShare A–2
week view, calendar 6–2
What’s New

link 1–4
using 1–8

wildcards, using in searches 10–7
WorkCentre, and scanning documents 13–

3
workflow, See routing a document
Writer access permission 1–6, 5–2
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